# TABLE OF CONTENTS

Overview: Seminar in Theological Research.................................................................1
Research & Writing Instructions.....................................................................................2
Using the Library Catalog System..................................................................................2
Developing a Research Strategy: 8 Steps to a Quality Research Paper..............17
Writing Skills..................................................................................................................17
  I. Style and Grammar.................................................................................................17
  II. Punctuation...........................................................................................................17
  III. The Paragraph.....................................................................................................18
  IV. The Basic Pattern for a Research Paper............................................................19
  V. Introduction and Narrowing the Topic.................................................................21
  VI. The Rough Draft..................................................................................................22
  VII. The Final Draft...................................................................................................23
Editing and Proofreading...............................................................................................23
Paraphrasing....................................................................................................................23
How To Do a Word Study...............................................................................................24
  Example Word Study.................................................................................................27
Writing a Book Critique.................................................................................................32
  Example Book Critique Format..................................................................................34
Writing a Biblical Issue Paper.......................................................................................35
Writing a Theological Issue Paper...............................................................................36
Form and Style Requirements.......................................................................................38
  Abbreviations, Apocrypha.........................................................................................38
  Abbreviations, English Bible.....................................................................................38
  Abbreviations, Bible Books.......................................................................................39
  Abbreviations, Misc. .................................................................................................40
  Abbreviations, Scholarly.........................................................................................40
  Abbreviations, States...............................................................................................41
  Abstract (Thesis).......................................................................................................41
  Bible Versions............................................................................................................41
  Bibliography/Bibliographic Sources and Documentation.......................................41
  Chapter Headings and Chapters..............................................................................42
  Commas.....................................................................................................................42
  Conclusions...............................................................................................................43
  Copyright....................................................................................................................43
  Ellipses......................................................................................................................43
  Emphasis Added........................................................................................................43
  Eras............................................................................................................................44
  First Pages...............................................................................................................44
  Fonts..........................................................................................................................44
  Fonts, Greek and Hebrew..........................................................................................44
  Footnotes...................................................................................................................44
Other Library Resources .......................................................................................................... 74
Footnote & Bibliographic Examples ............................................................................................. 78
  Multivolume Works .................................................................................................................... 78
  Bible Commentaries ................................................................................................................... 79
  Articles in Theological Dictionaries and Encyclopedias .......................................................... 80
  Periodicals .................................................................................................................................. 82
  Ancient Writers .......................................................................................................................... 83
  Electronic Documents ................................................................................................................. 85
  Miscellaneous ........................................................................................................................... 89
  Books ........................................................................................................................................ 92
  Journals/Magazines ................................................................................................................... 92
Example Pages................................................................................................................................ 94
Greek and Hebrew Text Citation Examples.................................................................................. 100
Common Problems with Form and Style..................................................................................... 103
OVERVIEW: SEMINAR IN THEOLOGICAL RESEARCH

GTHE 517 Seminar in Theological Research is designed to enable the theological research student to acquire a degree of expertise in the use of the library’s many facilities. The course emphasizes a working knowledge of research tools and research methodology, discusses selective problems in theological research, and addresses the scholarly process and modern information systems. Particular emphasis is placed on theological bibliography, critical methods of reading and studying, and writing. The course also examines the basic form, content, and style of an acceptable theological research paper. While the Research and Writing Manual was created as a resource for GTHE 517, it will also prove valuable as a reference when doing assignments for other seminary courses.

Required Textbooks

GTHE 517 Research & Writing Manual: Graduate School of Theology and Ministry Oral Roberts University—current year edition.


Recommended:

Seminar in Theological Research has two major components: gaining research skills and improving writing skills. To complete this course successfully, the student will need access to a city, county, university, or seminary library. Other sources for research could be a church library, pastor's professional library, online books, e-books, and Bible software programs (i.e. Logos). For this course, focus your research primarily on works by academically strong authors/sources (those with sound biblical/theological educations and/or are recognized experts in the areas on which they write/teach), not leaning too heavily on works by pastors, evangelists, and other ministers. Although many pastors, evangelists, and other ministers may have good things to say, especially in the area of personal application, often they do not deal specifically with the theological implications required by this and other courses. Exceptions to this can be found; however, please stay primarily with academically strong sources. On average, the student should plan a time commitment of six to eight hours per week to complete the course.
RESEARCH AND WRITING INSTRUCTIONS

Using the Library Card Catalog System:
All libraries have a means of indexing or cataloging the books and other materials they have in their collections. Generally, this information is kept in a card catalog.

Computer or Microfilm:
- Most libraries also make this same information available on a computer or a microfilm reader. You will need to check with the librarian to ascertain which information storage system(s) is used.
- Specific instructions for the use of a computer or microfilm system are usually posted near the appropriate piece of equipment. To save time, carefully read through the material provided by the library for the use of its particular system.
- If doing a subject or topical search for a book on Christian doctrine, and you found a book under the heading of “doctrine” or “theology,” the card might look something like this:

<table>
<thead>
<tr>
<th>Erickson, Millard J.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introducing Christian Doctrine/ Millard J. Erickson.</td>
</tr>
<tr>
<td>Grand Rapids: Baker, 1992</td>
</tr>
<tr>
<td>405 p. 26 cm.</td>
</tr>
<tr>
<td>Includes index.</td>
</tr>
<tr>
<td>ISBN 0-8010-3215-6</td>
</tr>
<tr>
<td>1. Theology, Doctrinal. I. Title.</td>
</tr>
<tr>
<td>BT75.2.E76 1992</td>
</tr>
<tr>
<td>230 dc20 92-16479</td>
</tr>
</tbody>
</table>

- The minimum information needed to locate a book and put together a footnote or bibliography entry includes the following:
  - The author's name
  - Title of the book
  - Editors/translators/revisers (if applicable)
  - Edition of book
  - City of publication (and state, if city not well known)
  - Publisher
  - Year of publication
- Additional information you might want, that is not part of the footnote or bibliographic entry, would be the library call number.
- Using the note card above, the bibliographic entry would look like this (note that the editor’s information is included):

A correctly-formatted footnote entry would look like this:


- The Library Call Number is: BT75.2.E76 1992
- All library cataloging systems (card, computer, etc.) will use either the Library of Congress numbering system or the Dewey Decimal system to catalog the books in their collections, and will include information about the book on each entry. In the example given above, the tracings indicate that this book is a "theological" and "doctrinal" work.
- When doing your research, you will begin your selection process by learning as much as you can about the book before you pull it down from the shelf. If the tracings tell you that it is a "fictional" work, it would have little, if any, value for an individual doing academic research.

DEVELOPING A RESEARCH STRATEGY: 8 STEPS TO PRODUCING A QUALITY RESEARCH PAPER

A research paper should be your own creation, not a mosaic of others' works or ideas. Unfortunately, many of the research papers that are turned in to professors are, at best, cut-and-paste jobs taken from several books and a few journal articles on an assigned topic. Such a paper is nothing more than a quickly-assembled report of other people's research. It takes very little talent or work to produce such a paper, and it adds nothing new to the academic process. In the first chapter, Vyhmeister covers what research is and is not, stating, "Research is not simply a compilation of quotations."

A research paper, however, develops when one has thoroughly investigated the topic under discussion, analyzed the material, and constructed the project in a new or creative way. The findings of the research may not be ground-breaking, but the manner in which they are presented should be original and clear. Such organizational processes can turn the average research paper into a treatise.

A quality research paper takes time. One cannot research and write the paper in one evening, or in an all-nighter. *A good rule of thumb is that for every page of text required, one should allow four to five hours for research and writing. Hence, a ten-page paper should take approximately forty to fifty hours of work.* That is the equivalent of two to three weeks of preparation and writing. Such a time commitment must be planned out and scheduled in advance. To construct such a paper, one must develop a clear, concise research strategy. There are eight steps necessary to the successful production of a quality research paper.

1. Select the Topic
2. Do Preliminary Research in Authoritative Summaries
3. Narrow the Topic
4. Build the Working Biography
5. Take Notes
6. Construct the Rough Draft
7. Rewrite and Polish the Rough Draft
8. Prepare the Final Copy
Step 1: Select the Topic

As you make your selection, be sure the topic selected will keep your interest during the entire research process. Such a topic should energize you, stir your imagination, and enliven your writing. Do not choose a topic just because it looks easy or because your professor seems to be interested in it. Selecting a topic that you are not interested in will probably cause you to write a very average paper. Select two or three tentative topics that you might be interested in, and then move on to the next step before you make your final selection.

Step 2: Do Preliminary Research in Authoritative Summaries

Authoritative summaries are a researcher’s best friend. The worst thing you can do is head straight for the card/computer catalog. When you base a paper on a few randomly-chosen books, you run the danger of repeating any biases or errors the writers may have. Also, this tends to commit you to a topic too soon.

Authoritative summaries are found in the Reference Section of the Library. Summaries allow you to "survey the forest" before you "focus on a tree." They can give you a broad perspective and help you avoid the errors produced by a limited outlook. They let you see how a subject has been subdivided, so that you can choose to focus on one of the subdivisions.

Summaries give you the five W's: Who, What, Where, When, and Why. Once you have read through a number of summaries, you may be able to develop a tentative thesis statement, and possibly even a preliminary outline based on that thesis statement. However, if the summaries fail to stimulate your curiosity in the topic, then you can switch topics without much loss of time.

Summaries are found in general encyclopedias, specialty encyclopedias, dictionaries, handbooks, and textbooks. Below is a small sampling of the types of reference material found in most libraries. As you work in the Reference Section of the library, you will find many other helpful tools that can be used to get an overview of the topic on which you want to write a paper.

Reference Materials

- An **encyclopedia** is made up of articles, alphabetically arranged, covering all branches of knowledge or devoted to a certain branch of knowledge. Encyclopedias are often overlooked sources of material. All research should begin with either a general encyclopedia or a specialized encyclopedia. Encyclopedias not only give a quick overview on a specific topic, but many provide a list of collateral readings or subheadings for additional research and consideration.

- A **dictionary** gives an alphabetical listing of words and the meanings of those words in a particular language. The terms' entries may include etymology (the origin and historical development of a word), pronunciation, and notes on usage. A dictionary is used to define terms that are found in a modern living language.
• A **lexicon** is a dictionary of a dead language, such as biblical Greek or Hebrew. Like a standard dictionary, it defines the term. But it goes much further, including the grammatical use of the term being discussed.

• A **vocabulary** is a special and partial kind of dictionary. It lists the terms that are used in a special branch of learning or science. Oftentimes, a vocabulary is given to help introduce the student quickly to new concepts or terms.

• A **Bible dictionary** contains an alphabetical list of words that will give one or more of the following pieces of information: (1) the meaning of a specific term; (2) the history of a particular individual or event; and/or (3) a list of examples of how the term is used in the Bible. This volume may also include outlines of the books of the Bible, maps, and other helpful tools.

• A **theological dictionary** deals with such issues as the doctrine of Christ, doctrine of humanity, salvation, miracles, eschatology, etc. It will generally present not only a biblical presentation, but also various positions held by individuals in different theological camps (e.g., liberals, conservatives, fundamentalists).

• An **atlas** is more than just a book of maps. It may include facts and figures; climatic, historical, or economic information; and biographical sketches on the people of an area.

• **Biblical histories** give a full account of the past, with interpretative and explanatory comments that distinguish them from mere annals or chronicles. A history is an interpretative rendering of a particular event in history told through the eyes of the author. A history is written from known and generally agreed-upon dates, individuals involved, and geographic locations. The reasons given for these historical occurrences are varied. Some historians base their interpretations on economic factors, some on philosophic factors, others on social factors, etc. To use history effectively in a research paper, the careful researcher must read and analyze several historical works. Then, try to locate the author's presuppositions and separate the purely historical from the speculative data presented in the work.

• A **Bible handbook** usually follows the chronological order of the Bible. It includes a running commentary on the specific portion of Scripture being studied. Handbooks are usually limited in scope and only give a brief overview of the material.

• A **Bible commentary** presents an in-depth study on a particular passage of Scripture. It includes the meanings of specific terms, the historical background on the passage, theological insights, and an exegesis of the passage. Again, one must be careful when using commentaries, due to the presuppositions of the authors. Several must be consulted, and compared and contrasted to gain a majority opinion on any issue.

• A **concordance** contains an alphabetical list of words that can be found in the Bible and provides references to the passages where the word occurs. It is related to a specific translation of the Bible (e.g., Strong’s to the KJV).
Step 3: Narrow the Topic

At first, you may think you have a fairly well-defined topic. As you read through the authoritative summaries, however, you may find that your topic is much broader in scope than you first thought. Based on your preliminary studies, this topic could easily become a term paper that is two or three times the size of that specified by your professor. In other words, the topic needs to be refined further, or narrowed in scope.

By way of illustration, let us assume that your professor has asked for a paper to be written on the topic of “sanctification.” At first, that might seem like a fairly straightforward topic. After all, the word “sanctification” means "to be set apart" or "to be holy." Two passages of Scripture tell believers that they are to be holy as God is holy:

"For I am the LORD your God. Consecrate yourselves, therefore, and be holy, for I am holy" (Lev 11:44, NASB).

"... because it is written, 'You shall be holy, for I am holy'" (1 Pet 1:16, NASB).

Upon further investigation, though, you will learn that sanctification is a fairly broad topic. It can be handled theologically or biblically. Theologically, sanctification can mean "perfection." Nevertheless, individuals from different theological backgrounds will interpret this word and doctrinal concept differently. For example, if the theologian is from a Wesleyan perspective, sanctification can mean "perfect love," "sinlessness," "baptism in the Holy Spirit," or "entire sanctification." When one is sanctified, one no longer needs to sin.

However, if the theologian is from a Reformed perspective, sanctification refers to “progressive sanctification.” Individuals from a Reformed background believe that from the moment that one accepts Christ, one is in the process of being made holy. The full ramifications of that experience will not be completed in this life. Believers, however, are to strive to live as holy as they can.

One can also look at this topic strictly from a biblical basis. Biblically, sanctification can be viewed in three ways: positionally, experientially, and ultimately.

1. One can be said to be in a positional state of sanctification because of the relationship one has in Christ. When God looks at a Christian, He looks at that person through the lens of what Christ has done for that individual. Hence, one is sanctified, or declared holy, because of the salvific work of Christ. Some theologians use the term “justification” to describe this.

2. A Christian is sanctified experientially when Jesus has taken up residence in the believer's life. He or she is a new creature and is free from the bondage of sin. This is not to say that Christian will not struggle with sin (Rom 7), but that they now have a way to resist sin. Experiential sanctification is seen in the production of the fruit of the Spirit (Gal 5).
3. Ultimate sanctification occurs when the believer stands before the Lord on the other side of eternity. At this point, one is either holy or one is not. One is either in the Kingdom or one is not in the Kingdom. There are no second chances. Some theologians use the term “glorification” to describe this.

As you can see, sanctification is a broader topic than you might have thought. The careful researcher would narrow the topic. The subject could be handled either theologically or biblically. Or, one could even further narrow the topic to one of the sub-points underneath these two categories. Such a narrowing process makes the research portion of this project much easier. Now, rather than reading broadly on the subject, you can confine your search only to those items which deal specifically with your selected topic. That is, of course, if the library you are using contains adequate resources to allow you to do such a project. That determination is made as one builds a working bibliography.

**Step 4: Build the Working Bibliography**

There are at least three reasons why one should develop a working bibliography:

1. It provides an overview of what sources are in the library.
2. It creates a list and location of books, periodicals, or other sources to explore.
   a. When dealing with books, be sure to include at least a book's call number, along with the author's name, title of the work, city of publication, publisher, and date of publication.
   b. Entries concerning periodic literature should always include the author's name, title of the article, journal or magazine name, date, volume number, issue number, and page number(s) of each article desired.
   c. Carefully noting this information at the beginning can save considerable time and frustration later.
3. A working bibliography allows the final bibliography to be constructed from the note cards quickly and easily.

Writing the entries for a working bibliography individually on 3 x 5 index cards makes them easy to handle, as they will fit in a shirt pocket, purse, or index box for easy access. Here are three general rules of thumb for the preparation of a working bibliography:

- Make only one entry per card
- Write each entry in ink
- Write on only one side of each card

It is essential to keep a separate, complete, and accurate card record of each source of information consulted. As soon as a new source is consulted, fill out a bibliographic card for it. Copy the bibliographical information exactly as it appears in the card/computer catalog, the *Reader's Guide to Periodical Literature*, or especially from
the title page and/or copyright page of the publication being considered. Do not abbreviate information, as you might forget what the abbreviation means.

Compiling a working bibliography begins with a search for the desired topic in the card/computer catalog and periodic index. One of the limitations of a catalog is the fact that it indexes only the general subjects of materials found in any particular library. The subject headings used are arbitrary, based upon the knowledge and expertise of the librarian cataloging that said item. A basic rule of thumb to use when searching a card/computer catalog is to look first under the subject heading that most precisely describes your topic. Then, if you need more material, use broader or related headings.

Materials listed in the card/computer catalog are categorized in three ways: by author, title, and subject. The main entry is the author card. This card will also allow the researcher to locate the works of artists, composers, translators, or editors. The title card allows one to search for a particular title to see if it is held in the library's collection. These cards are usually filed in the same cabinet as the author cards. Title cards are alphabetized according to the first word of the title, excluding "A," "An," and "The." Subject cards are filed in their catalog. Subject cards are important for locating sources that pertain specifically to the selected topic. Although the card/computer catalog does not evaluate library materials, you can make some preliminary judgments about that material by paying close attention to the information that is found on the card.

Based on the card below several value judgments could be made about whether this is a relevant volume.
A book may be two or more years old before it is published, whereas the time elapsed between the writing of a periodical article and the date of its publication may be only a few months or even weeks. For that reason, the serious researcher will explore periodicals, for they will contain the most current information on any given topic. Periodic literature includes such items as magazines, newspapers, newsletters, and trade publications.

To locate printed matter on a given topic in a periodical, you would use an index to periodic literature. An index will catalog those articles, editorials, or reviews that were printed in the volumes that they inventory. Indexes are issued at various times of the year in paperback form. At the end of the year, libraries will receive hardbound copies of these indexes. For that reason, you will want to check several paperback issues to obtain the most complete listings. A number of libraries will have computer indexes that you can use to locate periodic literature. These computer indexes are called "databases." Oral Roberts University subscribes to a number of these. As an Oral Roberts University student, you have the right to access these items. Go to http://www.oru.edu/university/library/. For more detailed information, see the ORU Library Resources section of this manual.

If you do not have access to a computerized database, the most popular index used by researchers is the Readers Guide to Periodic Literature. This volume indexes most popular and semi-popular periodicals. It deals with secular and some religious issues. Like the card catalogue, indexes will also use author, title, and subject headings. Additionally, this index also utilizes scriptural texts. A typical entry is displayed below:

Faith and reason

This particular article will be found in the November 10, 1972, edition of Christianity Today. The article will be found on pages 10-12. The author of this article is D. G. Kehl. The volume number is 17. Other indexes available are The Catholic Periodical and Literature Index, Religious and Theological Abstracts, New Testament Abstracts, and Old Testament Abstracts.

As you use any of these indexes, be aware that not every article listed in the index will be in the library that you are using. Most libraries indicate which volumes they subscribe to by placing a check mark on the abbreviation page that is found near the front of each index. You will want to scan that list before you begin your research.

**Step 5: Take Notes**

The most practical way to write a research paper is to use notes, which are prepared as one consults the various sources. If these notes are prepared properly, organization of the material will be much easier later. Notes should be made in such a way that sources should not have to be consulted again. The notes should contain a brief summary in the researcher's own words of the information obtained, as well as an adequate identification of the source (all the information needed to make a complete bibliographic
entry and a complete footnote entry). If you intend to quote a source directly, be sure to copy it exactly, including the original punctuation. *The researcher should exercise care, so as to avoid any misrepresentation of the original material.*

Many students make the mistake of taking notes in notebooks or on loose-leaf paper. Rather than separating the notes by author and title, copious notes are taken on one or more sheets of paper, one source right after the other. When the student begins to write the paper, there is no way to organize the notes adequately to make efficient use of them. The following guidelines will prove helpful when it comes to taking notes properly:

- Use 4" x 6" index cards to record notes. Carefully recorded notes can be rearranged in a helpful fashion when it comes time to producing the first draft of the paper.
- Record all the source information and the page number(s) before taking the note.
- Write all notes legibly in ink. Pencil tends to smear over time. When possible, photocopy material from the source and tape material to the index card.
- Record only one relevant item of information on each card. If the information spans to another card, be sure to indicate that fact carefully.
- Write on only one side of each card.

The time one takes during the note-taking process will be more than multiplied back to the researcher when the first draft is written.

The typical note card should include a subject heading, the author's name, the title of the work, and the page number(s) from which the material is taken. If quoting directly from the source, indicate this by use of quotation marks. There are times when material spans the bottom of one page and the top of the next. Such page breaks should be indicated on the card (as seen below).

---

**Reconciliation**


“The death of Christ also brings to an end the enmity... between God and humankind. Our hostility toward God is removed. The emphasis in Scripture is... that He reconciles us to himself. On this basis, the ad- (252) vocates of the moral-influence theory have contended that reconciliation is strictly God’s work.” (253)

---

If you find it necessary to continue the notes on additional cards for the same subject and reference, repeat the heading and sources on each card and number the cards in sequence (as seen below).
A general rule of thumb is never to take notes indiscriminately. Do not take down obvious, easily-remembered, well-known, or general statements. Record only that which is new to you or stated in an unusual way.

At first, during the note-taking process, the researcher may take notes copiously. This is a general fact-gathering mission. During this early process, the student is still formulating thoughts on that particular topic. As time goes by, the researcher will become more selective in the material that is recorded on the note cards. It is usually during the note-taking process that the thesis statement becomes solidified and a tentative outline for the paper develops.

Types of Note-Taking  There are four types of notes that one can take during the note-taking process:

1. **Rough Summary**: A running commentary or summary of material without much concern for grammatical correctness. The purpose of this type of note is to gather together the main points or ideas found in the source.

2. **Paraphrase**: A paraphrase is simply restating the author's material in your own vocabulary. Most notes should take this form. Should you use any of the author's original terminology, it should be placed in quotation marks.

---

Reconciliation 1 of 2
"The death of Christ also brings to an end the enmity and estrangement which exist between God and humankind. Our hostility toward God is removed. The emphasis in Scripture is usually that we are reconciled to God, that is, he plays the active role; he reconciles us to himself. On this basis, the **ad-(252) vocates** of the moral-influence theory have contended that reconciliation is strictly God's work." (253)

Reconciliation 2 of 2
Millard J. Erickson, *Introducing Christian Doctrine*, 252-253
"To answer, we need to note, first, that when the Bible entreats someone to be reconciled to another, the hostility does not necessarily lie with the person who is being addressed." (253)
It is better to paraphrase than to quote. If you cannot paraphrase a passage without continually looking at it, you are probably guilty of plagiarism. Plagiarism is the failure to give credit to an author for statements or ideas which are not your own. Merely reversing the order of words or making cosmetic alterations in sentence structure is inadequate. Plagiarism, whether intentional or unintentional, is grounds for immediate dismissal from this university. The University’s policy on plagiarism, stated on all ORU syllabi, is as follows:

“Students and faculty at Oral Roberts University must adhere to all laws addressing the ethical use of others’ materials, whether it is in the form of print, electronic, video, multimedia, or computer software. Plagiarism and other forms of cheating involve both lying and stealing and are violations of ORU’s Honor Code: “I will not cheat or plagiarize; I will do my own academic work and will not inappropriately collaborate with other students on assignments.” Plagiarism is usually defined as copying someone else’s ideas, words, or sentence structure and submitting them as one’s own. Other forms of academic dishonesty include (but are not limited to) the following:

- Submitting another’s work as one’s own or colluding with someone else and submitting that work as though it were his or hers;
- Failing to meet group assignment or project requirements while claiming to have done so;
- Failing to cite sources used in a paper;
- Creating results for experiments, observations, interviews, or projects that were not done;
- Receiving or giving unauthorized help on assignments.

By submitting an assignment in any form, the student gives permission for the assignment to be checked for plagiarism, either by submitting the work for electronic verification or by other means. Penalties for any of the above infractions may result in disciplinary action including failing the assignment or failing the course or expulsion from the University, as determined by department and University guidelines.”

3. Précis: A brief summary of the original source. The researcher condenses the material to about one-third of its original size. Care is given to maintain the character (tone) of the original item (e.g., satire, argumentation, etc.). A good example of this type of condensation would be the Reader's Digest condensed books. A good way to practice writing a précis would be to take a chapter and shrink it to a paragraph, or to take a paragraph and shrink it to a sentence.

4. Direct Quotation: A direct quotation is nothing more than a bald, unthinking restatement of the author's exact words. On the whole, students seriously abuse quotations, oftentimes using them for padding of the paper. A good rule of thumb is that a research paper should not have more than 10% of its content derived from direct quotations.
Direct quotations should only be used when:
- Exact wording cannot be improved upon;
- A point being made needs substantiation by an authority;
- Comparing/contrasting two views;
- A specific statement is being analyzed; and/or
- Exactitude is required—stating a formula, law, or edict.

**Evaluation of Sources**

Evaluation of the sources being used should occur during the note-taking process. There are five areas of concern.

1. **Relevance to the Topic**
   Is the source dealing explicitly with your topic, or is it only marginally or peripherally related? If it is a marginal treatment, seek other sources.

2. **Type of Source**
   Why settle for someone else’s understanding of a writer’s view? Get it straight from the "horse’s mouth." Whenever possible, go back to the original source. For example, many theologians talk about Dodd’s "realized eschatology." Rather than quoting a secondary source, the careful researcher will secure a copy of Dodd’s work and cite material from the original source.

3. **Author's Perspective**
   Is the author's presentation impartial and objective, or is it biased by presuppositions? Did the writer predetermine his or her conclusion? These are questions that need to be asked of each source utilized.

4. **Author's Credentials**
   Is the writer a well-renowned authority on the subject? Does the author's education and/or experience qualify him/her to write authoritatively and intelligently on this issue? When researching work on the internet, always search out the individual author(s) and the person(s)/group(s) sponsoring the website and material. Avoid blogs and *Wikipedia*.

5. **Readability**
   Is the source too technical for you to get a clear understanding of the author’s position? If it is, this could possibly lead to a misrepresentation of the writer. Is the source too devotional or sermonic? If so, then select another more academic source. (The only time you might want to look at devotional or sermonic material would be in the case where you are preparing a project that revolves around the teachings of a particular figure. At that point, those items would serve as original research.)
Step 6: Constructing the Rough Draft

When you have enough information to formulate a controlling idea or thesis statement, you can start formulating a tentative outline for the paper. The outline should follow standard outlining procedures and formatting. The mechanical formatting of an outline is illustrated below:

I. First Level Heading for Major Divisions
   A. Second Level Subheading for Major Points
      1. Third Level Subheading for Development of Major Points
      2. Third Level Subheading for Development of Major Points
   B. Second Level Subheading for Major Points

II. First Level Heading for Major Divisions

If an outline is well-constructed, it will flow naturally from point to point. The major divisions make up a logical presentation of the topic under discussion. In turn, each subheading underneath each major division will explain, illustrate, or define the topic being presented in that section of the paper. Each division of the outline should point back to the thesis statement. Once the research process is complete, you can construct a detailed outline of the paper.

I. This passage speaks to all people (John 10:8-11).
   A. Everyone has lost something.
   B. Many have been touched by the thief during this lifetime.
   C. Christians should prepare for the onslaught of the thief.

II. The activities of the thief (Satan) are to steal, kill and destroy (v. 10a).
   A. The thief comes to steal (robbery/burglary).
   B. The thief comes to kill (emotional death after loss).
   C. The thief comes to destroy (make useless).
   D. The thief is Satan.
      1. The thief steals vitality, time, and peace.
      2. The thief kills spiritually.
         “And fear not them which kill the body, but are not able to kill the soul: but rather fear him which is able to destroy both soul and body in hell” (Matt 10:28).
      3. Satan discourages people and destroys them.

III. The activities of the Good Shepherd (Christ) are to restore, give, and recreate (v. 10b-11).
   A. Christ restores shattered lives.
   B. Christ gives a reason for living.
   C. Christ recreates good things to replace what is gone.

IV. The activities of the sheep (Christian) are two-fold (v. 8).
   A. Do not listen to false shepherds.
   B. Be prepared for the onslaught of Satan.
V. In Christ, Christians can be safe, prepared, and face anything.
   A. Are the sheep (Christians) in the Good Shepherd’s Arms?
   B. Are Christians prepared to face the thief?
   C. Christians can be abundantly prepared to face anything the thief has planned
      against them (v. 10b).

Once the outline is on paper, transfer each first, second, and third level subheading to
note cards. Place one subheading on a card.

<table>
<thead>
<tr>
<th>II. The Thief’s Activities (v. 10a)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>A. The thief comes to steal (robbery/burglary)</th>
</tr>
</thead>
</table>

Now place the note cards that you prepared while doing research in the order of the out-
line you have prepared. With this step completed, you have organized your notes into a
rough draft on note cards. Then take some time off from the project. It could be as little
as a couple of hours, but it is best if you can put your work away for about a day. This
gives you a chance to rest and come back to the project with a clear mind later.

Prior to constructing the first draft of the paper, review the outline and notes, and
make any needed modifications. Then, start writing the first draft. *The rough draft
should be written in one sitting.* (Such a task is not possible if you are writing a thesis
or dissertation, but you could write a chapter in one sitting.)

The purpose of the outline and outline note cards is to help guide you through
the writing process. When constructing the first draft, move as quickly as possible. At
this point, do not concentrate on grammatical excellence. This draft is an attempt to get
something on paper; to state in as succinct a form as you can what the results of your
research have been. Generally, the first rough draft of most research papers is fairly
short. It usually does not include direct quotations. Quotations are usually placed in sub-
sequent drafts of the paper, although your draft may have a few quotations. Once you
have written the first copy of your paper, take some time off. There will be plenty of op-
portunity for revision and expansion of the paper.
Step 7: Rewriting and Polishing the Rough Draft

Once you return to the rough draft, the first task will be that of revising the text. Revisions may include the reconciling of the outline with the first draft of the paper. Also included is the process of eliminating unclear statements and gaps in continuity. This process needs to occur before you begin drafting the second version of the paper.

The second draft of the paper, for many people, is a total rewriting of the first draft. Unlike the first draft, it may take several sessions to complete the rewrite. This is a time of choosing the exact words needed to express best the idea that you want to convey. Quotations should be carefully selected and inserted into the paper.

Quotations in a research paper can be of two types: indirect (paraphrased or summarized) or direct (verbatim). Both indirect and direct quotations must be documented. That is, you must indicate the source by a superscript, or raised, number in the text and an accompanying footnote. See the appropriate section of this manual, Turabian, and Vyhmeister for appropriate formatting of notes and bibliographic entries.

Any fact or opinion that you read in any of your sources—whether you first discovered the idea there or have assimilated it so thoroughly that it seems to be your own—should be documented in your paper. Two exceptions are:

- Facts that are common knowledge, and
- Facts that can be verified easily and would not differ from one source to another (e.g., the Pope resides in Vatican City).

Under most circumstances, these kinds of materials would not need to be documented. Care should be taken at all costs not to plagiarize.

It is important for the researcher to know that acknowledgment of credit through documentation does not reduce the originality of your work, since your contribution consists of imposing your own order on the materials and drawing an original conclusion from them. Documentation allows your reader to see the materials you used to reach your conclusions, to check your interpretation of those sources, and to locate works in which other aspects of your topic might be discussed.

When borrowing material from others, it is important that you observe the "Fair Use" rule. In a nutshell, this rule states that a reasonable amount of a particular source may be quoted in an academic work without permission of the copyright holder. When a quotation comprises a substantial portion or the major emphasis of the source—this amount varies with the size of the source—permission needs to be sought. For a good discussion on the Fair Use Rule and copyright, go to http://www.nolo.com/legal-encyclopedia/article-30100.html, or http://www.copyright.gov/fls/fl102.html.

Step 8: Preparing the Final Copy

The final editing should include paying special attention to the relationship between the thesis statement (controlling idea) and the complete paper. The following checklist will be helpful in evaluating the final copy of the research paper.
Does the controlling idea govern everything in the paper?
Does the introduction prepare the reader for the paper?
Are the topic sentences clear and the paragraphs fully developed?
Are the paragraphs developed logically and arranged in a coherent sequence?
Do any sections repeat or contradict others?
Does the entire paper read smoothly, with transitions that carry the reader along from one idea to the next?
Does the paper conclude strongly—fully addressing the thesis statement?
Is every source used documented and cited properly?
Does the Bibliography only contain sources used in the paper?
Does the form and style of the paper conform to this manual, Vyhmeister, and Turabian?

If you were to evaluate the paper yourself, you might say "yes" to each of these questions; however, your paper may not be as well-organized as you think. As the author, you may be too close to view the paper objectively. For that reason, ask a friend to read the paper and then evaluate it according to the checklist above. You may find that the paper still needs some more work. Furthermore, an objective reader may have found spelling or grammar errors that you glossed over in your final reading of the paper. Once you have addressed these issues, print out the final draft and staple or bind it for submission (according to the requirements of the given course). The only thing left to do is to celebrate a job well done!

**WRITING SKILLS**

**I. Style and Grammar**

Before exploring the typical patterns used to construct an argument, time needs to be spent on the rudiments of style and English grammar. In a student's attempt to sound scholarly, the individual will often use a long, complicated sentence rather than a short, simple, concise statement. Instead of being written in crisp, clear sentences, the presentation is bogged down with excess and convoluted verbiage. Although this may add length to the paper (padding), it rarely adds any substantive material to the presentation. **The primary object of this course is to help students write clear and concise research papers.**

One's ability to write well begins with a rudimentary understanding of the English language. Grammar is not a subject that excites most people. However, to be a good communicator, one must continually improve one's grasp of the English language. This process takes patience and practice. It may be helpful to look at a good college English book for review.

**II. Punctuation**

Most students can handle punctuation in simple sentence structures. The first letter in a sentence should be capitalized. A declarative statement ends with a period. An
interrogative statement ends with a question mark. Commas usually set off parenthetical material. However, once the complexity of the sentence moves beyond this, students may have problems deciding whether to use a semi-colon, colon, or a dash.

Punctuation can cause a paper to read poorly. To improve your punctuation skills, you may also want to read chapter 1 of *The Elements of Style*, by William Strunk and E. B. White (2000).

### III. The Paragraph: The Basic Unit of a Research Paper

A research paper reflects all the work you have done. It showcases your research. It demonstrates your ability to think logically. It exhibits your skill at constructing a thesis statement and arguing it. Furthermore, it displays your competence in using the English language properly.

The basic unit that is used to convey your thoughts is the paragraph. In fact, a research paper is nothing more than a collection of paragraphs. The basic pattern for the paragraph is to state your topic for discussion, fully explain your topic, and conclude. Each of these items should be at least one sentence long. **Hence, a "legal" paragraph must be at least three sentences long.** The lack of such a pattern leads to disorganization. This basic pattern for a good paragraph is illustrated below.

<table>
<thead>
<tr>
<th>Topic Sentence</th>
<th>Explanation/Discussion</th>
<th>Conclusion/Transition</th>
</tr>
</thead>
<tbody>
<tr>
<td>The first sentence in the paragraph should either introduce the topic to be discussed or link this paragraph with the previous one. There is to be only one idea to a paragraph.</td>
<td>The next sentence(s) should amplify, explain, or argue the point introduced by the first sentence.</td>
<td>The last sentence should conclude the discussion or act as a transition to the next paragraph.</td>
</tr>
</tbody>
</table>

**Paragraph transitions are very important. They signal an end to the current train of thought and lead the reader toward the next item to be considered.** For this reason, care should be taken never to omit transitions. In fact, the more subtle the transition, the stronger the argument. Transitions are the means of directing your reader.

In the final draft of your paper, you will polish your paragraphs. Examine each paragraph to ensure that it states exactly what you want it to say. Write persuasively, so you are selling your ideas to your reader. Paragraphs should be written in such a way that your sentences direct the reader’s mind, so that it does not wander.

While reading your paper through before the final copy is printed, three questions need to be asked about each paragraph:

1. Is the idea in the paragraph prevalent?
2. Does this paragraph clarify or confuse the issue?
3. Does this paragraph belong here in the paper or somewhere else?
For further information read Chapter 2 of Strunk and White.

**IV. The Basic Pattern for a Research Paper**

The basic pattern for a research paper is very similar to that of the paragraph. It has three major components: Introduction, Body, and Conclusion.

1. **Introduction:**

   a. The thesis statement, proposition, or main point is the controlling idea of the research paper. It is where you make your proposition, pose your question, or state your case. The thesis statement is not a riddle. It should chart out the entire scope of the project. As you are outlining or writing your paper, you need to check the paper's content against the thesis statement. If the material used does not help build your argument—that is, support the thesis statement—then delete that material. Such a watchful eye will help you become a good writer while, at the same time, preventing you from doing the one thing that most college students do best when writing a paper: getting off topic.

   b. Introduces the reader to the specific topic under discussion. This could be a statement of problem, a proposition the author wants to put forth, a question to be answered by the research, or a thesis statement. Regardless of what one calls this section, it sets the tone for that which follows.

2. **Body:** The body of the paper is a collection of paragraphs that explains or argues the thesis. Depending upon the topic, this section could be analytical, comparative, chronological, or exegetical in content. There are various means of presenting this material. However, regardless of the format, the major purpose of the body is to defend the author's thesis statement or proposition.

   a. The body of the paper is the heart of your argument. In the introduction, you moved quickly from a general topic to the specific thesis. In the body, there is not the fast movement that there was in the introduction. This part of the presentation must be developed logically. Each point must be crafted carefully in order to move the reader from one paragraph to the next. Each paragraph should deal with only one argument or thought. The presentation will need to be specific, real, and concrete. **In the body of the paper, you are illustrating, explaining, and building your points.** When something needs to be defined, define or describe it clearly.
b. Early on in the development of the body, the researcher should anticipate possible objections and deal with them in a passive voice. The passive voice kills. You are not denying that potential problems exist, but you are not spending a great deal of time or energy on these issues. You are just stating the facts and moving on. After dealing with objections, move on to the positive aspects of your presentation. Begin with your weakest argument and ascend to your strongest. This process is referred to as moving from the lesser to the greater. Positive arguments should be presented in the active voice.

When presenting an argument, the author may find it helpful to use one or more of four existing patterns. Those patterns are listed below:

- **Chronological**
  The chronological pattern explains each item of an argument in a sequential order. The chronological pattern would be appropriate for a paper involving a series of events, such as history.

- **Comparison and Contrast**
  The pattern of comparison and contrast presents the similarities and/or differences between persons, places, things, or ideas. This pattern is suitable when a topic can best be understood by distinguishing it from others in the same group. A good example would be the comparison of Arminianism and Calvinism.

- **Cause and Effect**
  The principle of cause and effect involves the presentation of events or forces that produce certain results. It will include speculation about how things might have occurred if circumstances had been different. The cause and effect pattern is often used when writing an interpretative history.

- **Analysis**
  Some topics can best be understood by examining the component parts. Once the topic has been broken down, the specific components can be examined and discussed. This was the process discussed earlier concerning the topic of “sanctification.”

> *A strong paper will present an argument in the introduction, develop and defend that argument in the body, and then give a succinct conclusion.*

3. **Conclusion:**
   a. Concluding statement points back to thesis.
   b. The conclusion draws the presentation to a close. It should remind the reader of what has been read. Furthermore, it should also rephrase the thesis statement.
c. The conclusion is essential to completing the argument. It moves the reader from the thesis statement back to the broad perspective with which the paper started. Although it will contain a restatement of the thesis, it is more than just a vehicle to revisit that statement once again. The conclusion serves as a way to remind the reader of what was read earlier. In the conclusion, do not simply list the points of your argument. Rather, rephrase your points using sharp, clear, and concise words. *It serves to wrap up or complete the theological argument(s) for the thesis statement or to fully answer or address the question posed by the thesis statement.*

V. Introduction and Narrowing the Topic

Introduction

A strong introduction makes a strong paper. If you can grab the attention of your reader in the beginning paragraphs, that reader will be more apt to follow your presentation through to its logical conclusion. Dr. James Tollett illustrated this technique with this story about his career as a door-to-door Bible salesman:

“During the hot summers, I would earn money to attend college by selling books. One of the techniques the company taught us was to get the customers to agree with you at once; then when you were ready to close the sale, they would already be in the yes-mode. When I approached a person to sell a Bible, I would open with a statement like, ‘Ma'am, I know that you are a good woman who wants the best for her children.’ As I would say this phrase, I would be shaking my head up and down, indicating a positive statement. ‘I know that you are interested in the education of your children.’ Again, my head would be bobbing up and down. Continuing on, I would say, ‘And, we both know that they are not getting the education they should be getting in school.’ At this time, I would be shaking my head back and forth. By now, not only was my head shaking, but nine times out of ten, her head would be shaking the same way as mine.

“After several more minutes of conversation, I would again start shaking my head up and down and say, ‘I know that you want your children to have a good religious education, and would love to buy for them this beautiful Bible Story Book. And I tell
you what—I know money is tight, so why don't I take a deposit of $10.00 now, and in about a month when I deliver the book, you can give me the remaining $15.00? That sounds fair, doesn't it?’

“By this time, I would have filled out the sales slip and passed it to her. My head was nodding up and down, her head was nodding, and in a few moments I had a signed contract and a $10.00 deposit. What I was doing was leading her to where I wanted her to go. That is the same thing you do with an introduction.”

In the introduction, you are asking your reader to agree with you from the very start. You begin with things that most people would generally agree upon—those things which are considered to be true. You are finding points of agreement for affirmation. Then, quickly narrow your discussion to your thesis statement.

**Narrowing the Topic**

During the narrowing process, you may limit your topic by acknowledging that there are other areas that could be developed, but those are not the intent of this study. You are not denying the validity and importance of those other areas. Rather, you are acknowledging their existence and stating that for the purpose of this paper, they will not be covered. At the same time, you are telling your reader what you are going to discuss. This is directing your reader to where you want him or her to go. It is, if you will, getting the reader to shake his or her head "yes." The following illustrates this point.

Previously we discussed narrowing the topic using the illustration of "sanctification." As we walked through the process of what this theological term meant, we discovered that it could be handled biblically or theologically (even those two categories could be broken down into smaller units). Thus, we could narrow the focus—or thesis—down to one particular view of sanctification—for example, positional sanctification. In introducing this topic, one could acknowledge the breadth of the subject, but explain that in this treatise, only a specific concept of the topic is going to be fully presented. Thus, prior to presenting the thesis, you have narrowed the topic significantly.

**VI. The Rough Draft**

Having a comfortable and efficient work environment is a positive factor in the writing process. Make your space as conducive to work as you can. Your computer monitor should be properly adjusted for your line of vision, and your chair should appropriately support your frame. Make sure that you have ample supplies of paper, pens, pencils, note cards, etc., close at hand.

When putting together a first draft, some people need to be secluded in a quiet place. Others may listen to music and have other distractions around that help them to stay focused. You will need to find out how to establish a work environment that works best for you.
VII. The Final Draft

The final draft of your paper should follow all required form and style guidelines. Appearance is what catches your reader's attention first. If the appearance is correct and pleasing, your reader starts the encounter with a much better attitude, than if it were not. If it appears that care has been given to a paper in proper form and style, it gives an immediate sense of well-being to the reader. A carefully put together paper demonstrates the eye-for-detail that the author has in even the smallest of matters. Also, a well-constructed paper, in the proper form and style, is simply easier to read than one that is not.

EDITING AND PROOFREADING

Between writing the first rough draft of a paper and turning in the final polished version, one must go through a process of revision and rewriting. Using some of the basic techniques of editing and proofreading will greatly help in this process. Evaluate your writing for accuracy, clarity, coherence, consistency, and effectiveness. Use your computer’s grammar and spell-check, but remember that they are not foolproof—a word may be spelled correctly, but it may be the wrong word (there/their; bridle/bridal, etc.). You may have to revise your paper several times before all the issues are resolved—this is normal, and is part of the writing process. (Information adapted from William A. Sabin, The Gregg Reference Manual, 10th ed [NY: McGraw Hill, 2005], 349.)

Once you are satisfied with the content of your paper, read it again, checking to see that all form and style requirements are met (margins, formatting, etc.). Also check for inconsistencies in spacing, capitalization, etc. Refer to the Form and Style section of this manual for guidelines. And remember, it is always a good practice to have another set of “editing eyes” view your paper before turning in the final copy.

PARAPHRASING

A paraphrase is a restatement of an author's material using your own words. It is not your opinion about the original quotation. (That can be given and discussed after the paraphrase within the text of a research paper.) When preparing your paraphrase of a quotation, you should always do the following:

- Read the source material carefully.
- Always introduce your paraphrase by identifying the author of the quotation that you are paraphrasing.
  - This is especially important within the text of a paper, since you will not be using quotation marks to set off the material.
  - You need to be careful that the reader of your paraphrase is not left thinking that the material is your own (which would be plagiarism).
- Be sure you understand what the author is saying, as well as what the author is not saying. Do not misstate and/or misrepresent the author's material.
- Be sure to include all points made by the author.
Example 1
Quotation:
"My belief is that within the lifecycle of every believer there should be two distinct power levels. The first power level is experienced at salvation. The second power level should begin to develop when the individual is baptized with the Holy Spirit." James Caroll Tollett, "'Ye Shall Receive Power'—Venturing Forth into Life in the Spirit" (D.Min. proj., Oral Roberts University, 1986), 12.
Paraphrase:
James Caroll Tollett holds that in the course of their lives, all believers should distinctly experience two levels of spiritual power—both the initial power of salvation and the succeeding power that begins with the baptism with the Holy Spirit.

Example 2
Quotation:
Paraphrase:
In his commentary on the Book of Exodus, James Caroll Tollett notes how the Holy Spirit is symbolized by oil. One example cited by Tollett is found in 30:31, when the Lord's priests and His worshipers were prepared for their service to Him by being anointed with oil.

Notice that both of the paraphrases of the above direct quotations clearly introduce/identify the author, do not misstate and/or misrepresent what the author said, and include/identify all the points made by the author.

HOW TO DO A WORD STUDY
There are many ways to gather research and use it. Up to this point, the discussion has centered on generic research that is performed using books and periodic literature. Now the focus will shift to a very specific type of research: doing a word study. A brief outline is presented, followed by a sample word study. Carefully study the steps listed below.

Steps To Doing a Word Study:
1. Select the word or words to be studied. This is usually a key word(s) found in a passage of Scripture. For example, in John 10:10 some of the key words would be:

   | Thief   | Kill   | Shepherd | Life   |
   | Steal   | Destroy| Abundant |
2. Use a Concordance
Check the selected word(s) in a concordance: Young’s Analytical Concordance and Strong’s Exhaustive Concordance are the best. Young’s is preferable, as it gives the particular Greek or Hebrew word before it lists the verses that contain that word. Strong’s requires you to cross-reference the particular number to ascertain the Greek or Hebrew word used in the specified verse.

3. Organize Verses
Organize the verses that utilize the English word by its Hebrew or Greek word. To understand the word better, break it down into its various forms (present tense, past tense, aorist, etc.). From this list, you will decide which Hebrew or Greek word you want to analyze. Oftentimes, a biblical author will use this word in a particular way.

4. Look Up the Word or Words
Look up the word(s) in a lexicon and/or a theological dictionary. There is a limited lexicon in each of the two large concordances mentioned above. Although such sources can prove to be helpful, it is better to use an unabridged lexicon, such as: the Brown, Driver, Briggs Hebrew and English Lexicon, William Gesenius’ Hebrew and English Lexicon, Walter Bauer's A Greek-English Lexicon of the New Testament and Other Early Christian Literature, Henry Liddell's and Robert Scott's A Greek-English Lexicon, Colin Brown's New International Dictionary of New Testament Theology, and Gerhard Kittel's Theological Dictionary of the New Testament. Vines is not a good source for a critical word study. Various computer programs, such as Logos, Accordance, Bible Works and Gramcord are also excellent. (Also, see ORU Library Resources section.)

5. Make Observations
Make appropriate observations about the word(s).
- What is the frequency of the use of this word?
- Who uses the term? (Paul, John, Moses, etc.)
- What is the genre?
- What are the immediate context and the universal context in which the word is used? How is this word used?
- How do you define the word?
- What applications can you make of that word to the Christian’s life today?

When formulating a word study, cover all of the six items listed above in point five. A sample Word Study on Exousia and Dunamis is included on the pages following.

**Directions for Doing a Word Study**

Prepare a biblical word study on your selected word. The paper needs to include all six of the items listed above. Pay particular attention to the formatting of the paper, using the sample paper provided and the form and style materials in this manual.
The paper should be between 3-6 double-spaced pages, or as directed by your professor.
Use properly placed and formatted page numbers.
Use properly placed and formatted footnotes.
Be sure to footnote the first Scripture citation with a statement indicating the translation that will be used for biblical quotations (see Form and Style section in this manual).

No first person use is allowed in the formal academic writing for this course, as well as most all of your other courses. This includes not only such singular forms as I, me, my, and mine, but also includes plural forms we, us, our, etc.
Subheadings are not usually required in a paper this short (check with your professor).
Include a properly-formatted and page-numbered bibliography at the end of your paper.
  - You must use at least three academically acceptable sources (or more, as directed by your professor).
  - If you use any online item(s):
    - Include the URL (Universal Reference Link, on some browsers called the address or location). This link must go directly to the document you are referencing, not to the home page of a database (unless your professor allows material from a database).
    - Do not underline the URL, and do not leave the URL in blue hyperlink font.
    - You can insert an appropriately-located space into the URL to divide it between lines in order to avoid a lengthy blank space at the end of a preceding line. (See Turabian’s instructions on p. 294 and examples in this manual.)

See example of a word study paper on the following pages.
EXOUSIA AND DUNAMIS

In the Greek New Testament, several words can be translated as “power.” The two most prevalent words best relating to the Christian’s life in the Holy Spirit are *exousia* and *dunamis*. These terms will be compared and contrasted herein.

The term *exousia* is used 108 times in the New Testament and can be translated “freedom of choice,” “right,” “power,” “authority,” “ruling power,” or “a bearer of authority.” The term has been used by all of the gospel writers, but its most frequent use is in Luke, 1 Corinthians, and Revelation. Generally, the term is used in conjunction with Jesus having the power to forgive one of sin (Matt 9:6; Mark 2:10; Luke 5:24), to release one from the throes of Satan (Matt 10:1; Mark 6:7; Luke 10:19), or to heal (Mark 3:15). O. Betz points out that “*exousia* . . . is used only with reference to people. It indicates the power to act which given as of right to anyone by virtue of the position he holds.”

John uses *exousia* in a particular way. For him, *exousia* is closely tied to the miracle of salvation. John’s concept of power is the right that a person has “to become

---


3 Betz, “έξουσία,” 610.
son of God” (John 1:12, 17:2). This privilege is not based upon the merits of the individual, but upon the efficacious grace of Jesus Christ. Commenting on John’s use of the term, Betz writes:

In John’s gospel Jesus’ plenitentiary authority is based on the fact that he is the Son and that he is sent (cf. E.g. Jn. 17:2); he has also been given the authority to the judge at the end of time (Jn. 5:27). But in the Johannine writings, as the Synoptics, Jesus seeks to save men rather than judge them. His power is not forcible domination, but absolute freedom to be a servant to the world. He has the *exousia* to give his life and to take it again (Jn. 10:18). Jesus’ sacrifice opens the way for believers to the Father (Jn. 3:16; 14:6). Those who receive him and believe in his name are given *exousia* to become children of God (Jn. 1:12).

This power to become a child of God is resident in God the Father and is His to bestow. This right, or power, rests in the goodness of God to whom it is related. Hence, at salvation, a person receives the right to become a Christian, yet that right should only be the beginning of the Christian’s empowering. This *exousia* is the entry level into the Kingdom of God; there still remains the *dunamis*—the empowering for service.

The term *dunamis* is used 118 times in the New Testament and can be translated “ability,” “abundance,” “power,” “might,” “violence,” “capability,” “deed of power,” “resource,” “strength,” or “force.” The term is used by the synoptic gospel writers and

---

4 O. Betz, “έξουσία,” 610.

5 O. Betz, “δύναμις,” 603.

Paul as an empowerment for ministry. George Eldon Ladd posits, “The Synoptics agree that Jesus was endowed by the Spirit to fulfill his messianic mission, that his mission would include a general endowment of the Spirit, and that his disciples would be enabled by the Spirit to meet whatever difficulties they might encounter.”

This empowerment is given to the believer through the baptism with the Holy Spirit, an experience held by Pentecostals/Charismatics as subsequent to the salvation experience. The baptism with the Holy Spirit expresses that one is empowered by means of the Spirit. The Holy Spirit indwells the person so as to enable the individual to perform or express those things or acts bringing glory and honor to God (Rom 8:9-11). In the baptism with the Holy Spirit, the believer is empowered for ministry—a ministry bringing glory and honor to God.

Luke reports, in Acts 1:8, “But you will receive power when the Holy Spirit has come upon you; and you shall be witnesses My witnesses . . .” This power is an enabling for service with all the rank and authority needed to accomplish the specified tasks. The power resident in the believer through the Holy Spirit is the ability to manifest those things (signs and wonders) that validate the presence of the Kingdom (Acts 4:33). These miracles are manifestations of the Kingdom of God and reflect the same type of ministry as that which belonged to Jesus—a ministry of building God’s

---


8 Unless otherwise indicated all Bible references in this paper are to the New American Standard Bible-Updated (NASU) (Grand Rapids: Zondervan, 1999).
Kingdom. Hence, the Spirit-empowered Christian is to continue the ministry of Jesus, which was proclaiming the Kingdom with the signs of that Kingdom being evident (Acts 1:1-4).

The Christian’s lifecycle should be that of power. With the acceptance of Christ, the believer is made an heir and a child of God. At the baptism with the Holy Spirit, the convert is empowered for ministry.
BIBLIOGRAPHY


WRITING A BOOK CRITIQUE

A book critique is a to-the-point summary and evaluation of a book. The paper should be between two to four full double-spaced pages in length. (Note: The length may vary with other courses; follow instructions for the assignment given within a particular course.) The book critique is to include the following four items, in this order:

- Bibliographic Entry
- Author Information
- Content Summary
- Evaluation

Bibliographic Entry Example:

See the Bibliographic sections in this manual, Turabian, or Vyhmeister for the correct examples of other bibliographic forms.

Author Information
The purpose of this section is to identify the author(s), translator(s), or editor(s) of the book. If available, present the author's background, academic training, practical experience, and other works written. You can help a reader understand a book by describing the author. *Contemporary Authors*, other biographical sources, and the internet may provide author information.

Content Summary
This section should be no more than one page in length. The first sentence should be as comprehensive and inclusive as possible. Summarize the entire book in one sentence. The remainder of the summary will then be an elaboration of this sentence, sharing your understanding of what the book is all about.

Be sure the summary covers the entire book. Do not be so detailed about the first part of the book that subsequent sections are not adequately covered. To avoid this problem, organize the summary carefully and logically. Also, do not get bogged down in specifics. The task is to summarize the entire book, not to focus on selected details. When citing material from the book, be sure to give the page number at the end of the material in parentheses, like the following example: "Preaching is not an easy assignment" (3).

Evaluation
The evaluation is the most crucial part of the critique. This is not a summary of the book's content, but a critical evaluation of what the author has to say. React to the book both positively and negatively. Because books, like people, are different, one cannot impose predetermined critical questions on the book. The following questions are often used for evaluation:
What is unique, significant, or interesting about the book?
Does it contain unusual historical, theological, or literary traits?
What biases (theological, philosophical, denominational, etc.) are evident?
What does the book or author teach us?
What is good about the book?
What is bad about the book?
Who would benefit the most from reading the book?
What practical applications can be made from reading the book?
EXAMPLE OF BOOK CRITIQUE FORMAT

Bibliographic Entry


Author Information

The purpose of this section is to identify the author(s), translator(s), or editor(s) of the book. If available, present the author’s background, academic training, practical experience, and other works written. You can help a reader understand a book by describing the author. *Contemporary Authors*, other biographical sources, and the internet may provide author information.

Content Summary

This section should be no more than one page in length. When citing material from the book, be sure to give the appropriate page number at the end of the material in parentheses (55). See the content summary paragraph above for further instructions on writing the summary.

Evaluation

The evaluation is the most crucial part of the critique. This is not a summary of the book’s content, but a critical evaluation of what the author has to say. React to the book both positively and negatively. See the evaluation paragraph above for further instructions on writing the evaluation.
WRITING A BIBLICAL ISSUE PAPER

In a biblical issue paper, you will:

- Address authorship, audience, genre, and dating. This is similar to the Word Study paper; also many of these items are covered in the Fee and Stuart text.
- Introduce the text in its appropriate context, both immediate and universal.
- Expound on the text, taking into consideration grammatical issues, word studies, textual problems, comparison/contrast with similar passages, or theological issues.
- Include appropriate application(s).
- Properly document with appropriate footnotes and bibliographic entries.
- At least six sources must be used (unless your professor wants a longer paper and/or more sources):
  - Two sources from books
  - Two sources from periodical articles
  - Two sources from pure website articles/references books/lexicons (according to professor’s instructions)
  - The structure of text of the paper—including footnotes and bibliography—must be in the format prescribed by this manual, Vyhmeister, or Turabian (see sample Word Study in previous section).
- The paper must be grammatically correct.
- While writing, consider the following criteria:
  - Introductory matters: authorship, audience, etc.
  - Use of context
  - Exposition of text
  - Application of text
  - Grammar/style
  - Logical progression of thought
  - Documentation
- Make sure you use academically acceptable sources.
- Follow this style manual, Vyhmeister, or Turabian accurately.
- Do not underline the URL or leave it in blue hyperlink font.
- You can insert an appropriately-located space into the URL to divide it between lines in order to avoid a lengthy blank space at the end of a preceding line.
WRITING A THEOLOGICAL ISSUE PAPER

A Theological Issue Paper is a research paper—not a sermon. Select a topic and handle it theologically. Hence, you will need to spend a good deal of time reading in systematic theologies written by theologians. You are dealing with a doctrine of the Christian faith.

Define/describe the topic based on the research you have done.
The definition will come from your work in concordances, dictionaries, and theological books and articles. Part of your task will be to derive your own definition based on the research. This definition may serve as the thesis statement for this paper.

Present a brief biblical presentation on the topic.
Cite significant passages of Scripture that deal with the topic at hand. You may want to go back and review the discussion on the treatment of "sanctification" to get an idea of how Scripture should be utilized.

Compare and contrast at least two primary theologians or theological views of this topic (unless your professor has different requirements).
Continuing with the sanctification illustration, the term means one thing to someone in the Wesleyan heritage (entire sanctification), but quite another in the Reformed tradition (progressive sanctification). In your paper, you should deal with such issues. It is crucial that you deal with academically sound (not self-proclaimed) theologians and theologies and not preacher’s sermons.

Present and defend your view of the topic utilizing the Bible, Church History, and theology.
In this portion of the paper, you are defending your definition and giving your reasons from the Bible, Church history, and theology.

Properly document with appropriate footnotes and bibliographic entries.
• Use at least six sources in the preparation of this paper (unless your professor wants more):
  o Two sources from books
  o Two sources from periodical articles
  o Two sources from pure website articles/reference books (as instructed)
• All documentation must be in the Turabian footnote/bibliography format. (APA in-text referencing format will not be accepted.)
• Footnotes and bibliographic entries must be in correct format (see this manual, Vyhmeister, and Turabian.)
• The paper is to be grammatically correct.
• When writing, consider the following criteria:
  o Definition/description
  o Biblical presentation
  o Theological presentation
  o Biblical defense of student’s view
  o Historical defense of student’s view
  o Theological defense of student’s view
  o Grammar/logic/progression of thought
  o Form and style/documentation
Form and Style

If any man wish to write in a clear style, let him first be clear in his thoughts; and if any would write in a noble style, let him first possess a noble soul.

—Johann Wolfgang von Goethe
## FORM AND STYLE REQUIREMENTS

### Abbreviations, Apocrypha

<table>
<thead>
<tr>
<th>Additions to Esther</th>
<th>Add Esth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baruch</td>
<td>Bar</td>
</tr>
<tr>
<td>Bel and the Dragon</td>
<td>Bel</td>
</tr>
<tr>
<td>Epistle of Jeremiah</td>
<td>Ep Jer</td>
</tr>
<tr>
<td>1 Esdras</td>
<td>1 Esdr</td>
</tr>
<tr>
<td>2 Esdras</td>
<td>2 Esdr</td>
</tr>
<tr>
<td>Judith</td>
<td>Jud</td>
</tr>
<tr>
<td>1 Maccabees</td>
<td>1 Macc</td>
</tr>
<tr>
<td>2 Maccabees</td>
<td>2 Macc</td>
</tr>
<tr>
<td>Prayer of Manasseh</td>
<td>Pr Man</td>
</tr>
<tr>
<td>Ecclesiasticus</td>
<td>Sir</td>
</tr>
<tr>
<td>(Wisdom of Jesus the Son of Sirach)</td>
<td>Sir</td>
</tr>
<tr>
<td>Song of the Three Children</td>
<td>S Th Ch</td>
</tr>
<tr>
<td>Susanna</td>
<td>Sus</td>
</tr>
<tr>
<td>Tobit</td>
<td>Tob</td>
</tr>
<tr>
<td>Wisdom of Solomon</td>
<td>Wisd Sol</td>
</tr>
</tbody>
</table>

### Abbreviations, English Bible

<table>
<thead>
<tr>
<th>Good News Bible</th>
<th>GNB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Living Bible</td>
<td>LB</td>
</tr>
<tr>
<td>King James Version</td>
<td>KJV</td>
</tr>
<tr>
<td>A New Translation of the Bible</td>
<td>Moffatt</td>
</tr>
<tr>
<td>New Century Bible</td>
<td>NCB</td>
</tr>
<tr>
<td>New English Bible</td>
<td>NEB</td>
</tr>
<tr>
<td>New International Version</td>
<td>NIV</td>
</tr>
<tr>
<td>New Jerusalem Bible</td>
<td>NJB</td>
</tr>
<tr>
<td>New King James Version</td>
<td>NKJV</td>
</tr>
<tr>
<td>New Living Translation</td>
<td>NLT</td>
</tr>
<tr>
<td>New Revised Standard Version</td>
<td>NRSV</td>
</tr>
<tr>
<td>New American Standard Bible</td>
<td>NASB</td>
</tr>
<tr>
<td>New American Standard Bible, Updated</td>
<td>NASU</td>
</tr>
<tr>
<td>Revised Standard Version</td>
<td>RSV</td>
</tr>
<tr>
<td>Today’s New International Version</td>
<td>TNIV</td>
</tr>
</tbody>
</table>
**Abbreviations, Bible Books**

- In modern academic usage, the abbreviations of the books of the Bible are not followed by periods.
- Abbreviate book names in footnotes or within parentheses; however, spell out book names in the text.
- Spell out the numbers for numbered books of the Bible when a sentence begins with a book name (e.g., Second Timothy). Use Arabic numerals (1, 2) for numbered books when the book name is in running text (e.g., 2 Timothy).

### Old Testament Abbreviations

<table>
<thead>
<tr>
<th>Genesis</th>
<th>Gen</th>
<th>2 Chronicles</th>
<th>2 Chr</th>
<th>Daniel</th>
<th>Dan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exodus</td>
<td>Exod</td>
<td>Ezra</td>
<td>Ezra</td>
<td>Hosea</td>
<td>Hos</td>
</tr>
<tr>
<td>Leviticus</td>
<td>Lev</td>
<td>Nehemiah</td>
<td>Neh</td>
<td>Joel</td>
<td>Joel</td>
</tr>
<tr>
<td>Numbers</td>
<td>Num</td>
<td>Esther</td>
<td>Esth</td>
<td>Amos</td>
<td>Amos</td>
</tr>
<tr>
<td>Deuteronomy</td>
<td>Deut</td>
<td>Job</td>
<td>Job</td>
<td>Obadiah</td>
<td>Obad</td>
</tr>
<tr>
<td>Joshua</td>
<td>Josh</td>
<td>Psalms</td>
<td>Ps</td>
<td>Jonah</td>
<td>Jonah</td>
</tr>
<tr>
<td>Judges</td>
<td>Judg</td>
<td>Proverbs</td>
<td>Prov</td>
<td>Micah</td>
<td>Mic</td>
</tr>
<tr>
<td>Ruth</td>
<td>Ruth</td>
<td>Ecclesiastes</td>
<td>Eccl</td>
<td>Naham</td>
<td>Nah</td>
</tr>
<tr>
<td>1 Samuel</td>
<td>1 Sam</td>
<td>Song of Solomon</td>
<td>Song</td>
<td>Habakkuk</td>
<td>Hab</td>
</tr>
<tr>
<td>2 Samuel</td>
<td>2 Sam</td>
<td>Isaiah</td>
<td>Isa</td>
<td>Zephaniah</td>
<td>Zeph</td>
</tr>
<tr>
<td>1 Kings</td>
<td>1 Kgs</td>
<td>Jeremiah</td>
<td>Jer</td>
<td>Haggai</td>
<td>Hag</td>
</tr>
<tr>
<td>2 Kings</td>
<td>2 Kgs</td>
<td>Lamentations</td>
<td>Lam</td>
<td>Zechariah</td>
<td>Zech</td>
</tr>
<tr>
<td>1 Chronicles</td>
<td>1 Chr</td>
<td>Ezekiel</td>
<td>Ezek</td>
<td>Malachi</td>
<td>Mal</td>
</tr>
</tbody>
</table>

### New Testament Abbreviations

<table>
<thead>
<tr>
<th>Matthew</th>
<th>Matt</th>
<th>Ephesians</th>
<th>Eph</th>
<th>Hebrews</th>
<th>Heb</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark</td>
<td>Mark</td>
<td>Philippians</td>
<td>Phil</td>
<td>James</td>
<td>Jas</td>
</tr>
<tr>
<td>Luke</td>
<td>Luke</td>
<td>Colossians</td>
<td>Col</td>
<td>1 Peter</td>
<td>1 Pet</td>
</tr>
<tr>
<td>John</td>
<td>John</td>
<td>1 Thessalonians</td>
<td>1 Thess</td>
<td>2 Peter</td>
<td>2 Pet</td>
</tr>
<tr>
<td>Acts</td>
<td>Acts</td>
<td>2 Thessalonians</td>
<td>2 Thess</td>
<td>1 John</td>
<td>1 John</td>
</tr>
<tr>
<td>Romans</td>
<td>Rom</td>
<td>1 Timothy</td>
<td>1 Tim</td>
<td>2 John</td>
<td>2 John</td>
</tr>
<tr>
<td>1 Corinthians</td>
<td>1 Cor</td>
<td>2 Timothy</td>
<td>2 Tim</td>
<td>3 John</td>
<td>3 John</td>
</tr>
<tr>
<td>2 Corinthians</td>
<td>2 Cor</td>
<td>Titus</td>
<td>Titus</td>
<td>Jude</td>
<td>Jude</td>
</tr>
<tr>
<td>Galatians</td>
<td>Gal</td>
<td>Philemon</td>
<td>Phlm</td>
<td>Revelation</td>
<td>Rev</td>
</tr>
</tbody>
</table>

*Information adapted from Quality Research Papers by Nancy Vyheimster, p. 86, and SBL Handbook of Style (Peabody, MA: Hendrickson, 1999).*
Abbreviations, Misc.
You can find the abbreviations for the following writings in the abbreviation section of any volume of the *Word Biblical Commentary* (Dallas: Word 1988) or in the *SBL Handbook of Style* (Peabody, MA: Hendrickson, 1999):

- Commonly used periodicals, reference works, and serials
- Dead Sea Scrolls, Philo, and Josephus
- Early Jewish Literature (OT Pseudepigrapha); Rabbinic writings
- Early Christian Writings

Abbreviations, Scholarly

- Confine general abbreviations *etc.*, *e.g.*, and *i.e.* to parenthetical references in text.
- The abbreviations *cf.*, and *s.v.*, are preferably used only in footnotes.
- Latin abbreviations are not acceptable in the document citations.
- The most common scholarly abbreviations (for full list see Turabian 24.7):

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>App.</td>
<td>appendix</td>
</tr>
<tr>
<td>ca.</td>
<td>circa, about, approximately</td>
</tr>
<tr>
<td>cf.</td>
<td>confer, compare (Confer is Latin for “compare;” cf. must not be used as abbreviation for</td>
</tr>
<tr>
<td>ed.</td>
<td>editor; edition; edited by</td>
</tr>
<tr>
<td>e.g.</td>
<td>exempli gratia, for example</td>
</tr>
<tr>
<td>et al.</td>
<td>et alia, and others</td>
</tr>
<tr>
<td>et seg.</td>
<td>et sequentes, and the following</td>
</tr>
<tr>
<td>etc.</td>
<td>et cetera, and so forth</td>
</tr>
<tr>
<td>f., ff.</td>
<td>following (verse or verses, pages, etc.)</td>
</tr>
<tr>
<td>hap. leg.</td>
<td>hapax legomenon, sole occurrence</td>
</tr>
<tr>
<td>id.</td>
<td>idem, the same (used to refer to persons; not to be confused with ibid.)</td>
</tr>
<tr>
<td>i.e.</td>
<td>id est, that is</td>
</tr>
<tr>
<td>infra</td>
<td>below</td>
</tr>
<tr>
<td>n.</td>
<td>note, footnote (plural, nn.)</td>
</tr>
<tr>
<td>n.d.</td>
<td>no date</td>
</tr>
<tr>
<td>n.p.</td>
<td>no place; no publisher; no pagination</td>
</tr>
<tr>
<td>p.</td>
<td>page (plural, pp.)</td>
</tr>
<tr>
<td>passim</td>
<td>here and there; elsewhere</td>
</tr>
<tr>
<td>q.v.</td>
<td>quod vide, which see (for use with cross-references)</td>
</tr>
<tr>
<td>sic</td>
<td>so, thus (always italicized or underlined); an unusual</td>
</tr>
<tr>
<td>supra</td>
<td>above</td>
</tr>
<tr>
<td>s.v.</td>
<td>sub verbo, sub voce, under the word (plural, s.vv.; used in references to encyclopedias and</td>
</tr>
<tr>
<td>v.</td>
<td>verse (plural, v.)</td>
</tr>
<tr>
<td>viz.</td>
<td>videlicet, namely</td>
</tr>
<tr>
<td>vs.</td>
<td>versus, against</td>
</tr>
</tbody>
</table>
Abbreviations, States
In footnotes and bibliography use two-letter abbreviated form of the name of the state. Include state when the city may not be well-known to the reader. See Turabian 24.3.1

Abstract (M.A. Thesis)
- An abstract is a concise summary (approx. 150 words, normally on one page) intended to inform prospective readers about the content of a thesis.
- It usually includes a brief description of the research, the procedures or methods, and the results or conclusions.
- An abstract should not include internal headings, parenthetical citations of items listed in the reference section, diagrams, or other illustrations.

Bible Versions (also see Scripture Citations)
- In a biblical or theological paper, Bible references are commonly placed in parenthesis directly in the text. In English, it has been accepted practice that no version is indicated when one uses the King James Version (KJV). Any other version must be indicated in a footnote at the first Scripture reference in the paper:

1Unless otherwise indicated all Bible references in this paper are to the New American Standard Bible (NASB) (La Habra, CA: The Lockman Foundation, 1973).

- Although several versions may be used in the paper, this practice is discouraged. Unless word or sentence comparisons are being done between versions, use the same version throughout the paper. Jumping from one version to another and choosing the wording that suits a specific purpose suggests that the author of the paper is trying to make the Bible say what he or she wants it to say (“proof texting”).
- If a quotation from an additional version appears in the paper, indicate this with the abbreviation for that version following the citation: e.g., (Rom 1:17, NIV).

Bibliography/Bibliographic Sources and Documentation (see example pages)
- Source citations (footnotes) are required in the text when using a direct quotation, paraphrasing another author’s words, or including specific information that is not common knowledge.
- References in the text must correspond exactly to the listing of sources at the end of the paper. The bibliography should list only works that are referred to or quoted in the text.
- Be certain that all items are included in the bibliography that appear in the footnotes, author’s names are spelled consistently and correctly, and the dates are the same in both the footnotes and the bibliography.
Bibliography continued
- Categorize your sources according to type: Books, Periodicals, Online Sources, etc. Use the same format as you would for 1st level headings and alphabetize within each category. Do not list a source in more than one section unless it could clearly be categorized in two or more ways. See example Bibliography near end of manual.
- GTHE 517: For research paper, approximately 8-12 sources needed, as instructed by professor (1 source per page length of paper).
- GBIB/GTHE 757: For M.A. Thesis, between 60-75 sources should be used; at least one-third should be periodicals.
- Margins: Top (first page) 2”; (following pages) 1.4”; Left, bottom, and right 1” (NOTE: for M.A. Thesis, left margins are 1.5” to allow for binding.)
- Pagination (Page numbering)
  - Continue numbering from the last page of the main text.
  - Page number on first page is centered 0.75” from bottom.
  - Following page numbers are 1 inch from top and right edge of page.
- To transfer footnote information to the bibliography:
  - Go to View, switch to Draft.
  - Click Insert, Show Notes.
  - Select all (Ctrl+A) then Copy (Ctrl+C)
  - Open Bibliography (should be separate document) and Paste (Ctrl+V)
  - Arrange and format accordingly.

Chapter Headings and Chapters (M.A. Thesis)
- Begin each chapter on a new page;
- Use capital letters and Arabic numerals (CHAPTER 1) 2” from top of page.
- Title of chapter is in all capital letters, doubled spaced from chapter designation.
- 3 blank lines between chapter title and text; text begins on 4th line.
- An M.A. thesis is normally divided into 3-5 chapters.
- Introductory and concluding sections are included in the first and last chapters.
- Subheadings will indicate the orderly progression of topics and their relationships.

Commas
- The subject of comma usage is much too comprehensive to include here. Read and refer to Turabian 21.2 for specific directions.
- In a series, always use a comma before the conjunction that introduces the last item:
  \[ \text{He studied Greek, Latin, and Hebrew.} \]  (Turabian 21.2.2)
- Use paired commas to set off a nonrestrictive clause (a clause that is not necessary to identify the noun it modifies):
  \[ \text{These five books, which are on reserve in the library, are required reading.} \]  (Which books? These five books.)
- Restrictive clauses: Commas are not used around restrictive clauses (a clause that is necessary to identify the specific noun it modifies):
  \[ \text{The books that are required reading are on reserve in the library.} \]  (Which books? The books that are required reading.)
Conclusions

- A conclusion is essential to complete an argument, and draws the presentation to a close.
- It contains a restatement of the thesis, and reminds the reader of the main points.
- In the conclusion, do not simply list the points of your argument. Rather, rephrase your points using sharp, clear, and concise words.
- Do not use a quotation/paraphrase from someone else as a concluding statement.

Copyright© (M.A. Thesis)

- Copyright privileges vest immediately upon creation of the work, without the requirement of notice or registration formalities. One should, nevertheless, include a copyright notice with the work. It signals an acknowledgment of legal rights to the readers, copyright ownership, and indicates the first year of publication.
- Registration is technically optional, but still recommended. It establishes a public record of the document, the copyright, and the author’s name and address. For American publications, registration is required before one can file an infringement lawsuit.
- Timely registration bestows additional legal rights, particularly the ability to receive "statutory damages" and attorney fees in an infringement action. Those remedies may be the sole monetary award from an infringer. In general, to have these benefits, authors must register before the infringement occurs.
- For more information, see ProQuest UMI: www.umi.com/hp/Support /DServices/copyright/Part5.html. U.S. Copyright: www.copyright.gov, or call (202) 707-3000.

Ellipses (See Turabian 25.3.2)

- An ellipsis is a series of periods, separated by spaces, used to mark an omission of words, phrases, or paragraphs in quoted material.
- To omit material between sentences but quote the sentence preceding the omission in full, put the terminal punctuation mark immediately after that sentence; then leave a space between the ending punctuation mark and the ellipsis dots:
  
  “When a nation is wrong, it should say so and apologize. . . . It should also take steps to change the situation.”

- If the omission does not include the end of the preceding sentence, put a space instead of a punctuation mark immediately following that sentence. After the space, use three spaced ellipsis dots to represent the omission:

  “When a nation is wrong, it should say so . . . It should also change the situation.”

Emphasis Added (See Turabian 25.3.1)

- To italicize for emphasis words that are not italicized in an original quote or your text, you must indicate the change with emphasis added.
- Within the text, add notation in square brackets [ ] immediately after italicized words: According to Schulz, “By the end of 2010, every democracy [emphasis added] will face the challenge of nuclear terrorism.” To add italics at two or more points in a quotation or text, use the [emphasis added] after the last point.
- Only use “emphasis added” for quoted materials.
Eras
- Use BC and AD, or BCE and CE.
- Use capital letters without periods.
- AD precedes the year; the other designations follows it:
  
The temple was destroyed in 586 BC and again in AD 70.

First Pages (Main Text, Bibliography)
- The format of the first page is different than subsequent pages in a paper.
- Top margin: 2"; (1.4” on subsequent pages).
- Page number: centered 0.75” from bottom; (1” from top and right margins on subsequent pages).
  Also see Line Spacing section.

Fonts
- The accepted font type for the paper is Times New Roman.
- The font size is a standard 12 for both text and footnotes.
- Bold print is not acceptable for any portion of the document.
- Use italics or underline only when Turabian gives the option.

Fonts, Greek and Hebrew (and other biblical era languages)
- If Greek or Hebrew (or other) text is used, avoid bold type of font. If the font looks bold (even if not selected as bold), it must be approved before use.
- The citations of Greek or Hebrew (or other language) texts are put in block quotations.
- Hebrew text is right justified.
- To download font from your computer:
  - Go to Control Panel (Click Start on lower left corner of screen)
  - Open font folder.
  - Select and copy (Ctrl + C) the Greek and/or Hebrew font used and paste it (Ctrl + V) to the flash drive.
- To space Hebrew text properly in your paper, conform to the following guidelines:
  - Select Text, then click on Format, Paragraph.
  - Under Line Spacing select Exactly and type 24 into the pt box.
  - Block Quotes should be spaced at exactly 12 pts.
  - Double Space = 24 pts; Single Space = 12 pts.
- Free Hebrew and Greek fonts are available at www.teknia.com/free_fonts.
- Do not italicize foreign words in non-English alphabets (e.g. Greek, Hebrew).

Footnotes
- Text and footnotes are separated with a two-inch unbroken line (made automatically by word processor), beginning at the left margin.
  - Footnotes are to be typed immediately below the separation line.
Footnotes continued

- Footnote separators that extend across the page are not acceptable.
- The first line of each footnote should have same indentation as the paragraph indentations in your text (one-half inch).
- No space should appear between the footnote number and the footnote itself.
- Footnotes must be in 12-point font.
- Footnotes must be single-spaced when more than one line in length; the second and following lines are left justified.
- Double-space between footnotes.
- Number footnotes sequentially throughout the paper.
- M.A. Thesis only: Footnote numbers must begin at 1 again at the beginning of each chapter.
- Do not repeat the full citation of a source if it was used previously.
- For example, when referring to a source that has already been cited in full, give only the last name of the author and the page number.
- Include title if there are more works by the same author.
- Latin abbreviations are not acceptable (e.g., *Ibid.*, *op cit.*).
- Endnotes and parenthetical references (as used in MLA or APA style) are not acceptable.
- To transfer footnote information to the bibliography:
  - Go to View, switch to Draft.
  - In MS Word 2007, go to Reference tab; in Footnotes group, Show Notes.
    (In Word 2003, click Insert, Show Notes.)
  - Select all (Ctrl+A) then Copy (Ctrl+C)
  - Open Bibliography (should be separate document)
    and Paste (Ctrl+V)
  - Arrange and format accordingly.

Foreign Language Terms/Transliterations

- Italicize transliterations and isolated words and phrases in foreign languages likely to be unfamiliar to readers of English.
  “The terms *parabolē* in Greek and *mashal* in Hebrew require some qualification.”
- If you define a foreign term, put the definition in parenthesis or quotation marks following the term in the text.
  In biblical criticism, *Sitz im Leben* is a German phrase roughly translating to "setting in life."

Greek Citations

- Block quotes need to begin one-half inch from left margin, double-spaced after text.
- The English translation of the text also begins one-half inch from left margin, double -spaced after citation of Greek text.
- At the end of the translation, double space been the translation and the start of the remainder of the main body of text.
- Both the Greek text block quote and the English translation are single-spaced.
**Headings and Subheadings** (M.A. Thesis)

- Think of the headings as the outline of the paper; you must have at least two headings in a level. (You can’t have an A without a B in an outline)
- Subheadings must use exactly the same wording as the Table of Contents
- If the subheading text itself extends two lines, single-space the subheading.
- All headings use the same font as the text of the paper
- Do not type a heading near the bottom of a page unless there is a room for at least two lines of text following the heading (see Widows and Orphans Section). Instead, simply leave a little extra space on that page and begin the heading on next page.
- Neither bold nor italics is acceptable for headings.
- Also see section on Line Spacings.
- Subheadings can consist of up to five levels, although not all five need to be used unless they are applicable to the organization of the text.
  
  **Level 1 - Centered and Underlined**

  **Level 2 – Centered and Not Underlined**

**Level 3 – Justified Left and Underlined**

**Level 4 – Justified Left and Not Underlined**

  **Level 5 begins a paragraph.** It is underlined and has a period at the end. The text then continues as normal.

**Hebrew Citations**

- For block quotes, use same format as for Greek (above), *only use right justification for Hebrew text.*
- To space lines with Hebrew text properly:
  - Select text
  - Click on Paragraph tool bar
  - Under Line Spacing, select Exactly and type 24 into the pt. box  
    (Double space = 24 pts.) (Single space = 12 pts.)
- Block quotes should be spaced at exactly 12 pts.
- Do not italicize foreign words/phrases in non-English alphabets.

**Hyphens and Dashes**

- A hyphen is a single line between two words made with one stroke of the hyphen key (e.g., Tulsa is a fast-growing city).
- Avoid using hyphenation in your document, unless there is excessive space at the end of the line.
Hyphens and Dashes  continued

- An em-dash (width of an “M”) is made with two conjoined hyphens to set off text in a way similar to but more prominent than commas (e.g., Research reading—beyond the early exploratory reading—takes time.).
- An en-dash (width of an “N”) usually means “through” and is used to connect numbers and, less often, words:  The years 1993–2000 were heady ones.
- Do not leave spaces before or after hyphens or dashes.
- See Turabian 21.7 for more information

Inclusive Language

When possible, avoid gender-specific language when referring to human parties (use “people” or “humanity” rather than “men”). With regard to God, use masculine pronouns. See CMS 5.222-5.227.

Indentation

The first line of the paragraph begins one-half inch from the left margin. The whole of a block quotation is indented (not tabbed) one-half inch from the left margin.

Italics

- Book Titles
  - Italicize book titles in bibliographic and footnote entries/citations.
  - Italicize book titles in running text.

  *The Mishnah* and *The Jewish Encyclopedia* were crucial in the research findings.

- Emphasis Added (Turabian 25.3.1)
  - If you italicize for emphasis words that are not italicized in an original quotation, you must indicate the change with emphasis added.
  - Within the text, add notation in square brackets [ ] immediately after italicized words:
    According to Schulz, “By the end of 2010, *every democracy* [emphasis added] will face the challenge of nuclear terrorism.”
  - If you add italics at two or more points in a quotation or text, use the [emphasis added] after the last point.

- Foreign Language Terms/Transliteration
  - Italicize transliterations and isolated words and phrases in foreign languages likely to be unfamiliar to readers of English.

  “The terms *parabolē* in Greek and *mashal* in Hebrew require some qualification.”
  - If you define a foreign term, put the definition in parenthesis or quotation marks following the term in the text.

  In biblical criticism, *Sitz im Leben* is a German phrase roughly translating to "setting in life.”
  - Do not italicize words/phrases in non-English alphabets.
Justification

Left justification is the standard for a paper. Right justification is not acceptable in any area of the document. The only exception is with Hebrew block quotations, which are right justified.

Length of M.A. Thesis
- 75-100 pages, Times New Roman 12 pt. font
- Do not use an appendix to exceed the maximum length of the body of the thesis.

Line Spacing
- Text is to be double-spaced.
- Single spacing is allowed in certain limited cases: block quotations, headings, table titles, figure captions, tables, and appendices. It is also permitted within items in the list of tables, list of figures, bibliography, and footnotes.
- Line spacing of multiple (1.15 and other increments) is not acceptable.
- Between end of text and next subheading: 3 single spaces (2 blank lines between; text starts on 3rd line)
- Between subheading and text: 2 single spaces or 1 double space (1 blank line between; text starts on 2nd line)
- For Bibliography first page: between “BIBLIOGRAPHY” and “Books” section: 4 single spaces or 2 double spaces (3 blank lines between; text starts on 4th line)
- Between “Books” section and first bibliographic entry: 2 single spaces or 1 double space (1 blank line between; text starts on 2nd line)
- See examples below. The paragraph mark (¶) is included to show line spaces.

LINE SPACING EXAMPLES:

Clearly one of the most distinctive points of time in the history of the church is the
Pentecostal outpouring that came like a flood in the early part of the twentieth century.

According to most sources, William J. Seymour was the dominant figure in this historic
event. ¶

¶ Azusa Street

There are 2 blank single-spaced lines between text and next heading.

Heading is on the 3rd line.

The Azusa Street Revival significantly shaped and impacted the Pentecostal
churches of America in the early part of the twentieth century. . . .
Line Spacing continued

BIBLIOGRAPHY (ALL CAPS)


Margins
The margins should be set as follows:
- Research papers: left 1”
- M.A. Thesis: left 1.5” (to allow for binding)
- Bottom and right 1”
- Top 2” (for title page, first page of text, and bibliography)
- Top 1.4” (for following pages)

Names with Junior, Senior, and III
Commas are no longer required around Jr. and Sr, nor are they used to set off II, III and such as part of a name:

George Wilson Sr. has finally finished his thesis.

John Downey III is the son of John Downey Jr.

Numbers
- Spell out numbers under 101, except for Scripture references, dates, or years of ages.
- There were seventeen manuscripts in the library.
- He had studied 257 sources to write his book.
- If a number has two words, use a hyphen (fifty-five).
- Spell out round numbers followed by hundred, thousand, etc.
- The population of the area was twelve million.
- Always spell out a number that begins a sentence.
- Four men went in search of a lost civilization.

Pagination (Page Numbers)
Every page in the document, including Bibliography, must be counted.
- Body of Paper:
  o Pagination should be started from the first page of the main text and continued throughout.
  o Use Arabic numbers (1, 2, 3) of same size and font type as the main text.
Pagination  *continued*

- The page number on the first page is centered 0.75” from bottom of page.
- Following page numbers are 1 inch from the top and right edge of page.

- Bibliography
  - Continue numbering from the last page of the main text
  - Page number on first page is centered 0.75” from bottom.
  - Following page numbers are 1 inch from top and right edge of page.

Paragraphs

- The first line of each paragraph should be indented one-half inch.
- A paragraph must have at least three sentences.
- Avoid “widows and orphans”—carrying over just one line of a paragraph to the following page or starting a paragraph with one line at the end of the page. Set the “widow and orphan control” to automatically prevent the above from happening.

Print Quality

- Only sharp laser quality print with uniform blackness is accepted.
- Print single-sided only.
- If a laser printer is not available, transfer the document onto a flash drive or disc for printing at another location, such as Kinko’s or the ORU Document Preparation Services.

  - *Warning:* When using another computer and/or printer, often formatting is automatically changed; for example, the last line on a page may shift to the next page, or tabulations may change.

- Saving your document as a PDF file will minimize formatting changes during printing; however, some adjustments may still be needed.
- See Embedding Fonts section.

Quotation Marks

- The period ending the quotation should be placed before the quotation mark (.”).
- If quoted material ends in a semicolon or colon in the original, the punctuation can be changed to a comma or period to fit with the structure of your sentence.
- Use ”?” or ”!” if the punctuation refers to entire sentence of which quotation is part.
- Use ?” or !” if the punctuation is a part of the quoted material.
- Use a single quotation mark (‘) for a quote within a quote.
Quotations

- All quotations are to be introduced:
  
  *While most scholars accept this theory, Dr. John Jones denies its viability:*
  
  *“There is no evidence whatsoever to support this.”*

- Use the full name of an author when he/she is mentioned for the first-time. Subsequent references to an author can refer to last name only.

- When referring to the stated views of present or past writers, use the historical present tense (see Vyhmeister, p. 119).

- Suggested verbs that can be used to introduce quotations:

<table>
<thead>
<tr>
<th>accepts</th>
<th>asks</th>
<th>denies</th>
<th>mentions</th>
<th>proposes</th>
<th>stipulates</th>
</tr>
</thead>
<tbody>
<tr>
<td>adds</td>
<td>believes</td>
<td>describes</td>
<td>objects</td>
<td>recalls</td>
<td>submits</td>
</tr>
<tr>
<td>admits</td>
<td>combats</td>
<td>discusses</td>
<td>opposes</td>
<td>recommends</td>
<td>suggests</td>
</tr>
<tr>
<td>affirms</td>
<td>confirms</td>
<td>expresses</td>
<td>points out</td>
<td>reports</td>
<td>thinks</td>
</tr>
<tr>
<td>agrees</td>
<td>declares</td>
<td>indicates</td>
<td>points to</td>
<td>reveals</td>
<td>verifies</td>
</tr>
<tr>
<td>argues</td>
<td>defends</td>
<td>labels</td>
<td>portrays</td>
<td>states</td>
<td>writes</td>
</tr>
</tbody>
</table>

Quotations, Block

- Block quotations must be five or more lines of text in length; Greek and Hebrew citations are the exception.

- Must be single spaced, and indented one-half inch from left margin only.

- No quotation marks at the beginning or end.

- If the block quotation itself is a complete paragraph in the original source, the first line of the block quotation is tabbed an additional one-half inch.

- Quotations should be typed exactly as in the original, including wording, spelling, capitalization, and punctuation. If a word is misspelled in the quote, place [sic] immediately after the misspelled word. This designates that the incorrect spelling appears in the original.

- Note: Hebrew and Greek passages are always put in block quotes, whatever the length. For further information, see Turabian 25.2.2.

Scripture Citations (also see Bible Versions and Bible Abbreviations above)

- “Bible” should always be capitalized.

- The following Bible versions are suggested for the paper: KJV, NASB, NIV, NKJV, NLT, NRSV, RSV, or TNIV (see Abbreviations, English Bible).

- Footnote the first Scripture citation with a statement indicating which translation will be used for quotations, along with the publisher’s information. Example:

  2Unless otherwise indicated all Bible references in this paper are to the New American Standard Bible (NASB) (La Habra, CA: The Lockman Foundation, 1973).

- All subsequent scriptural citations should appear in the body of the paper and not in footnotes.
**Scripture Citations  continued**

- If a quotation from an additional version appears in the paper, indicate this with the abbreviation for that version following the citation: e.g., (Rom 1:17, NIV).
- Do not use excessive wording when referring to Scripture. For example, do not write, “chapter fourteen verses 3 through 6.” Simply write “14:3-6.”
- Multiple citations within the same chapter are separated by commas (e.g., Rev 3:6, 11, 13), but semicolons separate citations from different chapters and books (e.g., 2 Thess 2:1; 3:4; Rev 3:16).
- When chapters or verses are cited in parentheses, use ch./chs. and v./vv. (e.g., ch. 3; chs.1, 3; v. 1; vv. 4-9).
- Abbreviate Bible book names in footnotes or within parentheses (See Abbreviations Bible Books); however, spell out book names in the text.
- Spell out the numbers for numbered books of the Bible when a sentence begins with a book name (e.g., Second Timothy).
- Use Arabic numerals for the numbers of numbered books of the Bible when the book name is in running text (e.g., 2 Timothy).

**Spacing After Punctuation**

- There is to be one space after all punctuation marks ending each sentence.
- Do not leave a space after colons when used in Scripture references (1 Cor 1:2), between hours and minutes (5:20 p.m.), or between volume and page numbers (2:123-142).
- Do not leave a space after periods in abbreviations such as i.e., e.g., Ph.D., A.M., P.M.
- Single space after periods of the initials of personal names, (R. C. A. Lentki).

**Table of Contents (M.A. Thesis)**

- The TOC is essentially a topical outline of the work, compiled by listing the headings in the thesis, using the exact same wording.
- The title, disclaimer, approval, abstract, copyright, and vita pages are not included.
- See Setup Instructions in the Formatting the Paper section.

**Tables/Graphs (M.A. Thesis)**

- All figures must have narration in the text to introduce or conclude. The narration (explanation) for a figure comes after the figure itself.
- See Turabian 26.1.1; 26.2.2; 26.3.2, and chapter 8 for more detailed information.
Tabs
Default tab should be set at 0.5 inch.

Title page
- Top margin, 2”.
- Type title of the work using all capital letters; double space between lines if needed.
- Be sure the title is in the shape of an inverted pyramid (if more than one line)
- Use transliteration for Greek or Hebrew words if used in the title.
- Line 1: Title in (or first line of title)
- Line 28 “In Partial Fulfillment . . .”
- Line 36: “By”
- See example of title page in Example Pages section
- To help in setting up title page:
  - Set margins
  - Go to Page Layout and click Line Number
  - Click Continuous
  - As you go down the page, the line numbers will automatically show up on your left so that you know what line you are typing on.
  - When you’ve finished, go back to Page Layout, click Line Number, and unselect Continuous; the line numbers will disappear.

Vita (M.A. Thesis)
- The Vita is a brief biographical sketch of the writer which should include the date and place of birth, parents’ names, schools and colleges attended, degrees awarded, and professional experience.
- It comes after the Bibliography and has no page number.

Widows and Orphans
- An “orphan” is a heading or the first line of a paragraph that remains as the last line on a page.
- A “widow” is the last line of a paragraph alone at the top of the next page.
- Neither is acceptable and can be prevented.
- Make sure at least two lines of text in a paragraph remain together.
Formatting the Paper

Art and science have their meeting point in method.

—Edward Bulwer-Lytton
FORMATTING THE PAPER

The following formatting instructions are based on the program Microsoft Word 2007 for Windows. This manual is prepared specifically for students writing biblical and theological theses according to the style requirements of the Graduate School of Theology and Ministry at Oral Roberts University.

SAVING YOUR WORK

Backing up
Immediately after beginning the first chapter, save this new document on the hard drive of your computer. It is recommended that a folder be created in which all documents pertaining to the paper will be kept. It is also absolutely essential that backup copies be made of the document and kept in a safe place, in the event that your computer breaks down, all work will not be lost. Therefore, at the end of each work session make a copy to a flash drive or CD.

AutoRecover
The AutoRecover feature lets Word automatically save your document periodically. If the computer unexpectedly shuts down, (i.e., due to a power blackout) the document will be recovered. It will be opened the next time Word is launched. To set AutoRecover feature:
1. Click on the Office button and go to Word Options.
2. Click on Save tab on the left-hand side of the screen.
3. Click on the check box and enter the time period for AutoRecover.
4. Click OK.
You will be able to see the progress of AutoRecover saving in the Status Bar. If your document is large, Word may appear to have stopped functioning while the save takes place.

PAGE SETUP

● It is helpful to save each part of the paper as a separate document: i.e., Title Page, Main Body, Bibliography, etc. Creating a template for each of these is recommended.
● Make sure to set the margins, header and footer, font, etc. for each individual document.
Margins and Paper Size
To set the margins on the page:
1. Click on the Page Layout tab and open the Page Layout dialog box by clicking the appropriate arrow.
2. Click on the Margins tab if it is not on the top.
3. Select margins: Top 1.4,” Bottom 1” and Right 1.”
   NOTE: Research papers: Left 1”; M.A. Thesis, Left 1.5” (to allow for binding)
2. Click on the Paper tab.
7. Click OK.
Your margins, paper orientation, and paper size are set.

Setting the Default Font
Times New Roman 12-pt. is the required font type for all papers. You can set the default font type for all of your documents. To set the default font type:
1. Click on the Home tab and open the Font dialog box.
2. Click on the Font tab if it is not on the top.
3. In the Font box, select the font type you would like to use in your paper.
4. Font Style—select Regular.
5. Size—select 12.
6. Click Default button and OK. The default font is set.

Widows and Orphans
An “orphan” is a heading or the first line of a paragraph that remains as the last line on a page. A “widow” is the last line of a paragraph alone at the top of the next page. Neither is acceptable and can be prevented by following these guidelines:
1. Click on the Home tab and open the Paragraph dialog box.
2. Click on the Line and Page Breaks tab.
3. Put a check mark in front of Widow/Orphan control.
4. Put a check mark in front of Keep with next. (This prevents the subheading from appearing at the bottom of the page with no text below.)
5. Click OK.
Page Breaks

To set the text to appear on the top of the next page (e.g., a new heading) do not press the enter key until the text falls onto a new page. When you print your paper, the text could drift back to the previous page. Instead of using hard returns, you should insert a manual page break function.

To set a page break:
1. Position the cursor after the last line of your text where you want the page break to appear.
2. Click on the Insert tab.
3. Click Page Break in the Pages section of the menu.
4. A new page will open.

Hyphenation

Automatic hyphenation is not be used in a paper. This function should be turned off in your document.

To turn off the automatic hyphenation:
1. Click the Page Layout tab.
2. In the Page Setup section of the menu, click the Hyphenation button.
3. Click None.

Line Spacing

The text of the paper is to be double spaced. Before beginning to type the text of the paper, set the double spacing in your document.

To set proper spacing:
1. Click on the Home tab.
2. In the Paragraph section of the menu, click the Line Spacing button.
3. Click the number 2.
4. The text is now set for double spacing.

PAGE NUMBERS

- Arabic numbers are used for the body of the text and bibliography
- (For M.A. Theses only: Use lower case roman numerals for the front matter.)
In order to avoid problems with numbering in a Word document, it is recommended that you create a separate file for the body of the paper, as well as for the title page and bibliography.

Numbering the Front Matter (M.A. Thesis)

- The first part of the front matter consists of pages without numbers (title page, disclaimer page(s), approval, abstract, copyright, dedication, and preface).
- The second part has lower-case roman numerals at the bottom of each page (dedication, preface, acknowledgments, table of contents).
- In order to number the front pages you can create a separate document for every page and insert proper page numbers or leave it blank.

There is also a way to create page numbers in one document consisting of all front pages. Arabic numbers should be used starting on the first page of the first chapter of the project.

Inserting the Page Numbers in One Document (M.A. Thesis):

1. Create a document consisting of all front pages.
2. Place your insertion point at the top of the acknowledgment page (if this is your first numbered page).
3. Go to the Page Layout tab. In the Page Setup section, click Breaks.
4. Click Next Page.
5. On the toolbar, click on the Insert tab, select Page Number.
6. In the Page Numbers selection list, select Bottom of Page.
7. Select the center-aligned page numbering format (generally titled ‘Plain Number 2’).
8. Go back to the Insert Tab, select Page Number, Format Page Numbers.
9. In the Page Number Format dialog box, select Roman numerals (i, ii, iii, …).
10. Under Page Numbering click on Start at and type the page number that you want (most likely number vi).
11. Click OK.
12. Go to Page Layout and then open the Page Setup dialog box.
13. Click on the Layout tab.
14. Set the header to 1” and the footer to 0.75”.
15. Under Preview, select apply to Whole Document.
16. Click OK. Now you should have numbers centered 0.75” from the bottom of the page.
Numbering the Body of the Text

- It is recommended that you create a separate document for the body of the paper and bibliography.
- Don’t forget to set margins, header and footer, and font etc. for each individual document.

To set page numbers for the second and following pages of the paper:
1. Insert a Page Break (Insert>Page Break) after the last word of your first page.
2. Place your cursor on the second page of your document.
3. On the toolbar, go to the Insert tab, select Page Number.
4. In the Page Numbers selection list, select Top of Page.
5. Select the right-aligned page numbering format (generally titled Plain Number 3).
6. Go back to the Insert Tab, select Page Number, Format Page Numbers.
7. In the Page Number Format dialog box, select Arabic numbers (1, 2, 3).
8. Select Start at and insert page 2.
9. Click OK.
10. Go to Page Layout and then open the Page Setup dialog box.
11. Click on the Margins tab.
12. Change top margin to 1.4”
13. Click on the Layout tab.
15. DO NOT select Different First Page.
16. Set the header to 1” and the footer to 0.75”.
17. Under Preview, select apply to This Point forward.
18. Click OK.

The number on the first page of the text and the bibliography must be centered at the bottom of the page. (NOTE: For M.A. theses, this applies to the first page of every chapter and the bibliography.)

To set the page number at the bottom of a page:
1. Place your cursor on the first page of your document.
2. Go to Page Layout and open the Page Setup dialog box.
3. Click on the Margins tab, change top margin to 2”
4. Click on the Layout tab, make sure header is set at 1”, footer at 0.75”, Section Start is set to New Page, and Apply To is set to This Section
5. Check/click the Different First Page box.
6. Click OK.
7. Go to **Insert > Footer > Edit Footer**
8. Manually place your page number (1) with alignment set to center.
9. You can substitute the following directions for steps 7 and 8:
   - With your cursor placed in the first page of your document, go to **Insert > Page Number > Bottom of Page** > then select the centered number format (generally listed as ‘Plain Number 2’).
   Repeat the process for each first page.

**TABLE OF CONTENTS** (M.A. Thesis)

- Create a separate document for the Table of Contents.
- Format margins 1.5 inch from the left and 1 inch from the right and bottom, and 2” from the top (second page top margin should be 1.4”).

**Dot Leaders and Page Numbers**

In order to create a dot leader between the heading text and the page number, you must set a right aligned tab with a dot leader in your document before you begin entering text and page numbers. If you attempt to do this manually with periods and spaces, you may end up modifying every line in your table of contents when you change your printer driver.

To set a right aligned tab with dot leader:
1. From the **Home** tab, open the **Paragraph** dialog box.
2. Click on **Tabs**.
3. In the **Tab Stop Position** box type 6.
4. Under **Alignment**, select **Right**.
5. Under **Leader**, select **1 None**.
6. Click **Set**.
7. Again in the **Tab Stop Position** box type **5.6**.
8. Under **Alignment**, select **Right**.
9. Under **Leader**, select **2 (…..)**.
10. Click **Set**.
11. Click **OK**.

Your tabs for dot leader and page numbers are set.

Next, after you type the text, position the cursor on the first line of your Table of Contents immediately after the word Acknowledgments, and click the tab button (on your keyboard) twice. The leader and short blank space will appear. Type the page number. Repeat clicking the tab twice for every page number in your Table of Contents.
### Table of Contents: Chapter Headings, Subheadings, & Hanging Indents Setup

(M.A. Thesis only)

Note: It is recommended that you set the dot leaders (previous section), type all the text of the Table of Contents first, and then start formatting it.

**To set chapter headings in the Table of Contents:**

Select chapter heading (or subheading, see below)

1. Click on the **Home** tab and open the **Paragraph** dialog box.
2. Click on the **Indents and Spacing** if it is not on the top.
3. In the **Indention** section, click on the down triangle under **Special**.
4. Select **Hanging** from the roll-down list.
5. In the **By** box, select 0.3”.
6. In the **Left** box select 0.3”.
7. Click **OK**. Next, position the cursor after the period behind the number of your chapter, and tab once (on the keyboard). The title of your chapter will align at 0.3” from the chapter number. Repeat the process with all chapter headings.

**Setting Hanging Indents for Subheadings in Table of Contents:**

- A hanging indent is characterized by the first line of the paragraph touching the left margin, and subsequent lines are indented. You will need to create hanging indents for the headings in the Table of Contents.
- Follow the above procedures, but in **step 6** in the **Left** box select **0.9”** (for first level subheading).
- **Click OK**.

Your hanging indent for the first level subheading is set.

You will have to repeat the process for every level of subheading that you have in each of your chapters of your Table of Contents. Insert the following numbers:

- Level 2 subheading: in the indention section select: **Left 1.2”** and **Hanging By 0.3”**
- Level 3 subheading: in the indention section select: **Left 1.5”** and **Hanging By 0.3”**
- Level 4 subheading: in the indention section select: **Left 1.8”** and **Hanging By 0.3”**
- Level 5 subheading: in the indention section select: **Left 2.1”** and **Hanging By 0.3”**

Repeat the process for every chapter in your Table of Contents.
BLOCK QUOTATIONS

Do not use spacing or tabs for block quotations. Follow these instructions to set a block quotation:
1. Select the text you want to quote in block.
2. From the Home tab, open the Paragraph dialog box.
3. Click on the Indents and Spacing if it is not on the top.
4. In the Indention section, in the Left box type 0.5.”
5. In the Spacing section, under the Line Spacing select Single.
6. Click OK. Your block quotation is set.
   Remember to double space before and after block quotations.

FOOTNOTES

Inserting Footnotes - In order to insert footnotes into your document follow these guidelines:
1. Position the cursor in the place where you want your footnote number to appear.
2. Click on the References tab.
3. In the Footnotes section, open the Footnote & Endnote dialog box.
4. In Location, select Footnotes & Bottom of Page.
5. In Format section, select Number from 1, 2, 3, …(if not already selected).
6. Click Insert. Type the text of the footnote. Backspace one to delete space after footnote number (if necessary). Repeat the process for each footnote.

Modifying Footnotes Style
In order to create the same style for all footnotes:
1. After entering first footnote notation, place cursor immediately after footnote number.
2. Right click the mouse.
3. A new box will open. Select Style.
4. The Style box will open with Footnote Text selected.
5. Click on the Modify button (see the picture on the right).
6. The Modify Style box will open. Select the font type and size to be the same as the main text of your document.
2. Next, click Format button and select paragraph.
3. A Paragraph box will open. Select indention: First line by 0.5.” Under Spacing After, set to 12 pt. Click OK. Click OK again. Click Apply.

Your footnote style is set. When you enter new footnote notations they will always be the same size, font type and the first line will be indented 0.5.”
Removing Footnote Continuation Separator

In order to remove footnote separator that is going all the way across the page do the following:

1. Click on the View tab and select Draft in the Document View section.
2. Next, click the References tab and, in the Footnotes section, select Show Notes. The page should split into two sections with footnotes being displayed in the bottom section.
3. In the bottom section, where it says Footnotes, select Footnote Separator; the short horizontal line will appear.
4. Select this short line and on the keyboard click Ctrl + C (copy).
5. Go to Footnote Continuation Separator.
6. Select this longer line and on the keyboard click Ctrl + V (paste).
7. Your Footnote Separator and Footnote Continuation Separator should be the same length.
8. Click Show Notes again to close the footnotes section of the page.

BIBLIOGRAPHY

- Do not use spacing and tabs to format your bibliography. Instead, use hanging indents (see the instruction in Hanging Indents of Heading).
- Select all bibliography and format hanging indents as shown on the picture (Indention: Left and Right 0,” Special—Hanging, By—0.5;” Spacing—Single).
- Make sure the spacing after selection is set to 12 pt.
- Double space between books and periodicals listed in the bibliography.
- Triple space between headings.
- Page number on the first page of the bibliography should appear centered at the bottom.
- Page number on following pages goes 1” from top and right margins
- In order to format numbers, follow the instructions for Page Numbering.
ORU Library Resources

Research is formalized curiosity. It is poking and prying with a purpose.
—Zora Neale Hurston
ORU LIBRARY RESOURCES

ACCESS TO ORU LIBRARY DATABASES
Many of ORU’s electronic resources are available via the Internet. Since your bibliography should include journal articles as well as books, you will find ORU’s databases very helpful in doing your research. Many databases store journal articles from thousands of journals and magazines either in full text or abstract form. Some databases contain the text of full length books. The use of ORU databases is restricted to ORU students and faculty.

When ORU Is Your Internet Provider:
To access the ORU Library databases, log onto the OR network with your Novell user name and password. Then, go to the ORU Library Web Page (www.oru.edu/university/library). Select a resource such as the library catalog, the journal list, or another electronic resource, and begin searching.

Via Another Internet Provider:
Go to the ORU Library Web Page (www.oru.edu/university/library). Click on "Off-Campus Access" in the listing in the top section of the right frame. A login page will pop up.

Fill in your Novell user name. Your user name is usually the same as your ORU student e-mail address less the @oru.edu. For example, if your e-mail address is gil26456@oru.edu, then your user name is gil26456. If you have forgotten your ORU e-mail address, go to https://vision.oru.edu and key in your student ID number and password as instructed. Once in Vision, click on "Personal Information," then click "View E-mail Addresses."

Fill in your Novell password. If you need help with your password, contact the Student IT Help Desk at (918) 495-6321, or email iservices@oru.edu.

After you have filled out your user name and password, the ORU library web page will open again. (When you log on successfully, the "Off Campus Access" link is gone.) You are now ready to select the library catalog, the Journals List, the Database List, or Central Search and begin searching.
JOURNAL SEARCH USING DATABASES

Topical Search in Journals
You may use ORU’s databases to search through the theological journals for a particular subject, keyword, Scripture, name, etc. To start searching, open the library’s main page and click on Database List (you will find it in the left menu).

Once the Database List opens, scroll down the page to find EBSCOhost Databases (All). Click it. When the new page opens, click EBSCOhost Research Databases. Now, check the boxes beside the databases you want to search. Theological databases include ATLA Religion Database with ATLASerials, New Testament Abstracts, and Old Testament Abstracts. Others are also available. You may wish to check Academic Search Complete as it indexes a significant number of theological journals. Once you have checked the desired databases, click Continue.

After the above window opens, you may begin your search. In the search box, type the subject or name that you desire to search. If desired, you may limit your search by selecting a particular field (e.g., title or author) or by using a limiter such as a range of dates.

ATLA Database Search
In the above search, four databases were selected, allowing you to search all four databases simultaneously. However, sometimes it is better to search within just one database (particularly ATLA, which is the largest theological database) because you can do specific kinds of searching such as Scripture searching which are not available when searching a combination of databases.

In order to search in the ATLA Database only, click the Choose Databases link above the search boxes. When the list of databases appears, select only ATLA Religion Database with ATLASerials. Along the blue tool bar at the top of the screen, you will see several options including Publications, Scriptures, and Indexes.

Select one to search. If you are interested in finding articles on a particular Bible passage, for example, click Scriptures. A new page will open with a list of passages. In the Browse box, enter the passage that you want to find. A list of references will open. Select one or more by putting a check mark in the boxes of the ones that pertain to your
search. Click **Search**. A list of citations to journal articles and essays related to the selected passages will appear.

You may also do a search for a particular subject. To do this, click on the **Indexes** link on the blue tool bar. Then in the **Browse an index** box, select **Subjects All**. In **Browse for**, enter the subject that you want to find. Click **Browse**. A list of sub­jects will open. Select one or more that relates to your interest and click **Search**. A list of citations to journal articles related to the selected subject will appear.

**Search for a Particular Journal Article**

You may also search for a particular journal article using the ORU databases. For example, if while reading and researching, you find a reference to a particular journal article and you want to read the full article, use the type of search described here to find the desired resources: To start the search, go to the main page of the library, and click **Journals List** in the left-hand menu. In the search box, type the exact name of the journal that you want to find (for example, *Journal of Biblical Literature*). Click **Search**. A new page will open with a list of results.

On the results page displayed in the image on the right, there are two types of findings for the search for *Journal of Biblical Literature*: (1) the ORU Library Catalog and (2) three online databases, *ATLA Religion Database with ATLASerials*, *Academic Search Complete*, and *Humanities International Complete*. (Be sure to note the date range beside each database. In this case the ATLA database has from 1943 to the present, whereas the other two have 1973 to the present.)

The ORU **library catalog** link leads you to the catalog entries of the journal holdings that are in paper, microfilm, and/or CD-ROM format. When you click the holdings link, the library catalog opens and takes you to two records related to *Journal of Biblical Literature*. The icons indicate the available formats: paper and microform.

In the **Journals List** example in the image at the top of the page, three databases are listed which contain articles from *Journal of Biblical Literature*. Click the name of a database that contains the date of the article that you are looking for (for example, *Academic Search Complete*). A new page with years of publication will open (see image to the right). Click the desired year, and then the desired volume and issue.
BOOK SEARCH USING THE LIBRARY CATALOG

You can search through the books and audiovisual materials available at the ORU library using the ORU online catalog. Go to the main library web page. In the left column, select ORU Library Catalogs, and then ORU Library Catalog. The page that opens is the library catalog.

Now you can begin your search. In the Search box, select your desired method of searching. For example, you can search the library's resources by title, author, subject, or call number, etc. Then, in the box to the right, enter a word or phrase appropriate to the index that you selected. Click Submit.

A new page will open with the results of your search (see image on the right). Click on a relevant result. A new page will open with a list of items available. Scroll through the list. When you find a title that looks appropriate, click it for more information. If you decide you want the book, write down the title, call number, and location in the library so you will know where to find it on the shelf.

Note: To go backwards and forwards in the results list, it is best to use Results List link provided in the catalog rather than the browser back button.

CENTRAL SEARCH

The library has a powerful resource called Central Search that allows simultaneous searching of virtually all the library databases.

Databases that are specifically theological in nature are not the only ones that contain religious or biblical materials; many multidisciplinary databases (e.g. Academic Search Complete) do as well. To identify which databases may have material relevant to your particular topic, go to the library home page and click Central Search. Then click Search by subject, and then click the box beside the word Theology. Now, in one of the search boxes, key in a keyword or phrase, and click Search.

The results page will indicate the number of items found by each vendor (e.g., EBSCOhost). To see the results within individual databases, click the plus sign beside the name of each of the vendors.
CENTRAL SEARCH  continued
Each of the databases that has results will have a number beside it. Click the name of the database to see the results in it. Begin scanning the results. When you find the title of a relevant item, click the title. You will be immediately taken to its record. If the full text of the item is available in that database, you will be able to click on a link to it. The full text is either in PDF or HTML format.

THESIS AND DISSERTATION SEARCH
Another kind of resource that you may find useful in your research are theses, dissertations, and applied research projects. These are searchable in the library catalog or in the databases.

Library Catalog. To search the Library Catalog for a project or dissertation, go to the Advanced Search page (see instructions Book Search using Library Catalog) and select Subject from the arrow-down box. Then in the first search box, type Research Projects, Applied, then select or in the drop-down box, and then select Subject again, and type Dissertations, Academic. Click Submit. A new page will open showing the total number of projects and dissertations in the library (see image on the right). Scroll the search. They will include works from other academic institutions that are in the ORU library, in addition to projects and theses by ORU students.

WorldCatDissertations Database. In order to access the WorldCatDissertations database, on the main page of the library, click on Databases. The Databases by Title page will open. Click the last entry on the list, WorldCatDissertations. The WorldCatDissertations Advanced Search page will open (see the image on the left). To find information on a specific title, do a keyword search for the author’s last name and two or three keywords from the title.

To search for theses in a general subject area, click the Subjects icon on the far left of the gray tool bar (as seen on the image on the right). Type your topic of interest. Click Search. Then scan the list for titles of interest.
REFERENCE RESOURCES

Numerous reference resources in the ORU Library may be used for theological or bibli-
cal research. Several of these are described below:

Bible dictionaries and Bible encyclopedias
To find general history or background information on persons, places, customs, subjects etc., use Bible dictionaries and Bible encyclopedias.

LRC-R indicates that the item is shelved in the Reference area.
NetLibrary, Ebrary or Credo indicates that the item is an electronic book avail-
able online (search for the title in the library catalog and click the link).
Otherwise, items are available in the Main Collection. Examples:

- Biographical Dictionary of Christian Theologians - Ebrary
- Britannica Encyclopedia of World Religions - Ebrary
- Companion Encyclopedia of Theology - Ebrary
- Critical Terms for Religious Studies – Credo
- Dictionary of Ethics, Theology & Society - ebrary (online); BJ63 D53 1996 LRC-R
- Dictionary of Pastoral Care and Counseling - BV4011.D43B 1990 LRC-R
- Encyclopaedia Judaica - DS102.8.E496B LRC-R (Look up your topic in the
  Index, vol. 1.) Also available online via the library Database List.
- Handbook of Contemporary Preaching - BV4222.H35 1992
- International Standard Bible Encyclopaedia - BS440.I6 1994 LRC-R
- The Jewish Religion: A Companion - NetLibrary
- Macmillan Dictionary of the Bible - Credo
Bible dictionaries and Bible encyclopedias continued

- **The New Encyclopedia of Judaism** - Credo
- **Prime-Time Religion: An Encyclopedia of Religious Broadcasting** - Ebrary
- **Who's Who in Christianity** - Credo
- **Who's Who in the Old Testament** - Credo
- **World Religions** - BL31.W67 1998 LRC-R

Concordances

To find a particular Bible verse when you know a key word, use concordances. Call number section BS425. Examples:

- **The New Strong's Expanded Exhaustive Concordance of the Bible** - BS425.S8 2001 LRC-R
  Contains Hebrew and Greek dictionaries to help you find terms.
- **The NIV Exhaustive Concordance** - BS425.G62 LRC-R
  Contains Hebrew to English Index-Lexicon, Greek to English Index-Lexicon, and Index of Strong’s/Goodrick Kohlberger numbers.
- **BibleGateway.com** - available on the Internet. Allows searching of a number of English versions of the Bible as well as several other language translations.

Specialized dictionaries, English

For in-depth research on a particular English word, see specialized dictionaries. Examples:

- **The Anchor Bible Dictionary** - BS440.A54 LRC-R
- **The Complete Biblical Library** (Harris) - BS2535.2.N474 LRC-R
- **Complete Word Study Dictionary** - PA881.Z63 LRC-R (Use the English index in the front of the book.)
- **Dictionary of New Testament Theology** (Brown) - BS2397.N48 LRC-R
Specialized dictionaries, English  continued


Commentaries

For in-depth research on a particular word, Bible verse, social and cultural milieu, etc., see commentaries. General call numbers section is BS490 through 491.5. Other commentaries are under call number according to the book of the Bible they discuss. Examples:

- *Collegeville Bible Commentary* - BS491.2.C66 1989 LRC-R
- *Eerdmans Commentary on the Bible* - BS491.3.E37 2003 LRC-R
- *The Expositor’s Bible Commentary* - BS491.2 .E96
- *Harper's Bible Commentary* - BS491.2.N4 1988 LRC-R
- *New Bible Commentary* - BS491.2.N45 1994 LRC-R
- *The New Interpreter's Bible* - BS491.2 .N484 1994 LRC-R

Commentaries often come in series. Some are shelved together, while others are not. To find a commentary of a particular book of the Bible in a particular series, do an advanced keyword search in the library catalog for the series title and for the name of the book of the Bible as a keyword (e.g. “Title”: Berit Olam AND “Keyword”: Ruth ). Examples of series are:

- *The Anchor Bible* (“Bible. English.Anchor Bible. 1964”) 
  BS192.2.A1 1964.G3 (*First Corinthians* available online via Ebrary)
- *International Critical Commentary*- BS491.16 LRC-R
- *International Theological Commentary* - BS1151.2.I57 LRC 4th Floor
- *Interpretation* - BS491.2.I56 LRC-R (some vols. available online via NetLibrary)
- *New International Biblical Commentary* - BS2341.2.N48 LRC-R
- *New International Commentary on the Old Testament* - BS1151.2.N4 LRC-R
- *The NIV Application Commentary* - BS491.2.N58 LRC-R
- *The Old Testament Library* - BS1151.2.O4 LRC-R
- The *Sacra Pagina* series on the New Testament - BS2341.2.S22 LRC-R
- *Word Biblical Commentary* - BS491.2.W67 LRC-R

72
Interlinear Bibles
For a translation and/or transliteration of ‘Hebrew’ or ‘Greek’ see *Interlinear Bibles*.

<table>
<thead>
<tr>
<th>Greek</th>
<th>Hebrew</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>The Interlinear Hebrew-Greek-English Bible</em> (Green, BS1 1976)</td>
<td><em>The Interlinear Hebrew-Greek-English Bible</em> (Green, BS1 1976)</td>
</tr>
<tr>
<td><em>The Interlinear Greek-English New Testament</em> (Marshall, BS1965 1959B)</td>
<td><em>The Interlinear Bible, Hebrew/English</em> (Green, BS715 1976X)</td>
</tr>
<tr>
<td><em>The Complete Biblical Library, “N.T. Study Bible”</em> (Harris, BS2535.2.N474, v. 2-10)</td>
<td></td>
</tr>
</tbody>
</table>

Specialized dictionaries (Hebrew and Greek)
For research on a particular Hebrew or Greek word, use specialized dictionaries, parsing guides, and lexicons.

<table>
<thead>
<tr>
<th>Greek</th>
<th>Hebrew</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>has Scripture, subject, &amp; numbering index</td>
</tr>
</tbody>
</table>

Parsing guides and analytical keys

<table>
<thead>
<tr>
<th>Greek</th>
<th>Hebrew</th>
</tr>
</thead>
</table>
Lexicons

<table>
<thead>
<tr>
<th>Greek</th>
<th>Hebrew</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Index to BDB Hebrew Lexicon</em> (PJ4833.B683)</td>
</tr>
</tbody>
</table>

OTHER LIBRARY RESOURCES

**eBooks:** Do an advanced search in the catalog, using *netlibrary* or *ebrary* as a keyword and a term such as *missions* or *theology* as a keyword. Or go to the eBooks page (from the Library page, find the *Read about eBooks*) and follow the directions there. Note that all 8,800+ of the netLibrary eBooks that ORU owns are searched simultaneously when you do a full text search from the *netlibrary* site. Similarly, the full text of 46,000+ eBooks is searched when you do a simple search from the *ebrary* site.

**Table of Contents:** One way to keep informed of what is being currently published in theology is to browse the tables of contents of related journals in FirstSearch's *Electronic Collections Online* (ECO). On the ECO page, click "Browse Journal Titles" and then, from the "All Subject Collections," select a category under "Philosophy. Psychology [B-BJ]" or "Religion & Religions [BL-BX]." Begin browsing. *Please note: ECO provides only a small amount of full text.*

**Other Formats:** Do a subject keyword search in *webPAC*. On the results list page, click a subject. In the page that opens, scroll down the list scanning entries for format icons. If the list is long, you may limit it to a particular format by selecting a format from the drop-down box (see picture on the left). Available format limits include *audiobooks, audio cassettes, DVDs, and ebooks*. After making a selection, click *Search*. The results will be limited to the selected format.

**Library Guides:**
Click on Library Guides from the Library home page, and scroll down the page to see the theology-related guides: Theology Resources; Theology/Bible Word Studies; Theological Reference Materials; Locating an Essay in the ATLA Religion Database; Foreign Countries, Cultures & Missions; Babylonian Talmud.
Library Tutorials:
The Library’s instruction librarian has created three new interactive tutorials that cover a variety of topics and research skills that will help you be a successful student. These online tutorials, available on the Library’s home page, will allow you to learn at your own pace.

Choose a tutorial appropriate for your level of skill and knowledge. If you are new to the University, begin with the "Library Orientation" for an introduction to the Library’s services, resources, and physical and electronic environments. "Research Basics" will explain how to begin a research project and give tips and tools for strategic searching, evaluating information, and avoiding plagiarism. If you live more than an hour away from the ORU campus, then begin with the "Distance Learners” tutorial, which will help you find out how the ORU Library can serve you even when you cannot be on campus.

Special Collections
- The ORU Theology Collection is located on the 4th floor of the LRC, primarily within the BJ-BX call number range. These books may be checked out.
- The Reference Library has a comprehensive collection of theological resources, to be used only in the library.
- The Holy Spirit Research Center, LRC, 5th floor
  - One of the largest and most comprehensive Pentecostal/charismatic and Holy Spirit collections in the world, it contains over 12,000 books, 300 magazines, 4,500 tapes, vertical files of tracks, pamphlets, brochures, unpublished papers, newsletter, and new articles, and hundreds of sound recordings, films, photographs, and microfilms.
  - Contact Dr. Mark Roberts, Director, for hours: 918-495-6899, or hsrc@oru.edu.

The following special collections are accessed by permission through the Circulation Desk. A key to the collection room may be checked out for a maximum of four hours.
- William Sanford LaSor Collection, LRC 408 E-F
- Elmar Camillo Dos Santos Collection (with collection below) LRC 408 L-M
- Jewish Theological Seminary Collection, LRC 408 L-M
- Temple Israel Library has a long-standing agreement to allow ORU students to check out their materials. You may visit the Temple library any time during normal business hours. For research assistance, see library committee, Tuesday mornings.
  - Search library catalog at http://titulsa.surpasssoftware.com/titulsa/
  - Temple Israel, 2004 East 22nd Place, Tulsa, Oklahoma 74114-2800 Administrative Office: (918) 747-1309
Online Jewish research sources

- Babylonian Talmud Research Guide (ORU Library):
  http://webapps.oru.edu/new_php/library/guides/talmud.html
- Jewish Encyclopedia: http://www.jewishencyclopedia.com/index.jsp
- Jewish National and University Library (JNUL) Digitized Book Repository
  - http://www.jnul.huji.ac.il/eng/digibook.html
  - Rare and out-of-print monographs
  - About 1,100 digitalized volumes, from 15th century incunabula to early 20th century works.
- Judaism:
  http://www.oru.edu/university/library/Elites/heologicalresources.html#JUD
- RAMBI: Index to articles and books on Jewish studies by the Jewish National and University Libraries. http://jnul.huji.ac.il/rambi/
- The Talmud (Yale University Library): http://www.library.yale.edu/cataloging/hebraicateam/talmud.htm
- WebShas–Index to the Talmud: http://www.webshas.org/

Note: This page was adapted from various sections of the ORU Library’s website (http://www.oru.edu/university/library).

(Library section rev. 6/2/10 S.S.)
Bibliographic Examples

Learn as much by writing as by reading.

—Lord Acton
FOOTNOTE AND BIBLIOGRAPHIC EXAMPLES

Turabian style is required for the bibliography and footnotes. Refer to Turabian chapters 16-17 for the general samples of style. This manual deals with the bibliographical entries that are most commonly used by theological students in the seminary.

- Use the standard 12-point font for footnotes and bibliography.
- When referencing a specific publisher, refer to the publisher exactly the same way in all notes and bibliographic entries.
- Never use a title in a note of bibliographic entry (Rabbi, Rev., Dr.)
- Never use degrees in a note of bibliographic entry (BA, MA, PhD)
- In the examples below, the first entry is for a footnote; the second for a bibliography.

MULTIVOLUME WORKS

1. **One author, several volumes:**
   


2. **One author, several volumes, translated:**


3. **One author, different title of each volume:**

   


4. **Independent Titles and Different Authors for Each Volume:**


5. **Multiple authors with the same name (Jr., Sr., III):**


**BIBLE COMMENTARIES** (In Bibliography, list under Books)

1. **Author given, no volume number:**


2. **Author and volume number given:**


3. **Several volumes by the same author:**

(Note: abbreviated names/initials are only acceptable when the full name is not cited in the original and is unknown. See example below.)


4. **Commentary as a part of the volume in a multivolume set:**


5. **Editor or Compiler as “Author”:**


**ARTICLES IN THEOLOGICAL DICTIONARIES AND ENCYCLOPEDIAS**

- In Bibliography, list under *Books*.
- In the footnote, indicate the page(s) of the particular reference cited.
- In the bibliographic entry, list the entire pagination of the article.
- A separate full entry is needed for each individual article from any one book.

1. **Signed article:**


2. Unsigned articles:

Dictionary/Encyclopedia articles without separate authors for each article:


3. Concordances: **List bibliographic entries for each individual word and a full footnote entry for first reference to each word in text.**


4. Lexicons: List bibliographic entries for each individual word and a full footnote entry for first reference to each word in text.


PERIODICALS

In the footnote, indicate the page(s) of the particular material cited in your text.

In the bibliographic entry, list the entire pagination of the article.

1. Journals with successive pagination throughout the different issues:


2. Journals with separate pagination for each issue:


ANCIENT WRITERS

   
   1. Irenaeus, *Against Heresies* 5.5.1 (*ANF* 1:530).


2. **Classical authors:**


3. Rabbinical or Jewish writings:


9 Mishnah *Sanhedrin* 10:2.


11 B. Talmud *Sanhedrin* 97a.


Rabbinical or Jewish writings: continued

13 *Song of Songs Rabbah* 7.7.1 (*Midrash Rabbah* 9:289).


14 *Tosefta Kiddushin* 1:12.


ELECTRONIC DOCUMENTS

- Important Note: Electronic/online references should be verifiable, academic sources. If a website’s reliability is in question, students need to consult their professor for approval.
- Web entries are to be no more than 1/3 of the total bibliographic sources.
- While the web provides numerous sites and is easily accessible, it is best to use it as a secondary source of information rather than the primary (see chapter 3 in Vyhmeister for further guidance on web sources).
- **Place in the following bibliographic categories:**
  - **Database** entries should normally be placed under Periodicals (or other appropriate category heading).
  - **E-Books** should be placed under Books.
  - **CD-Rom** references put with appropriate section, e.g., Periodicals, Books.
  - **Pure Web-Entries** should be placed under Other Sources.
  - Other web entries should be placed under appropriate category heading.
    - **Important:** With sites containing web addresses, the first date in the footnote and bibliographic entries should refer to the creation, revision, or last update of the article/information being cited.
    - The second date in the footnote and bibliographic entries refers to the day the site was accessed. In a professional site, the name in italics that precedes the article date is the name of the web site.

1. **Journal article from a database:**


2. Reference article from a database:


3. Journal article from online journal (ejournal):


4. Article in an electronic magazine (ezine):


5. **Online book:**


6. **E-Books**


- Indicate a format other than print at the end of the citation.
- If page numbers are not included in the electronic format, include an indication of chapter or section or other locator. (See CMS 14.17)


*Note different formats of same book:*

8. Book and Journals in print now on the Internet:


9. CD-ROM reference with a corresponding print edition:


10. CD-ROM Reference


11. Personal website:


12. Professional website:


13. E-mail:

15 Richard McBrien (rmcbrien@nd.edu), Reply to Query Regarding Catherine LaCugna, e-mail to Sally Shelton (sshelton@oru.edu) (16 February 2004).

McBrien, Richard (rmcbrien@nd.edu). Reply to Query Regarding Catherine LaCugna. E-mail to Sally Shelton (sshelton@oru.edu) (16 February 2004).

MISCELLANEOUS

1. Article in a Study Bible or book


2. Secondary source of quotation: (The “4, n. 16” in the reference below refers to page 4, “note” 16 in that source) (See other example under Journal Article from a Database.)


3. **Class papers:**


4. **Class notes (lectures):**


5. **Class handout composed by professor:**


6. **Reprint:**


7. **Component part by one author in a work edited by another:**


8. Footnote with multiple entries:


9. Archived sources:


10. Interview:

Choo Lak Yeow, Executive Director of the Association for Theological Education in Southeast Asia, interview by author, Singapore, 15 July 1985.

Yeow, Choo Lak, Executive Director of Association for Theological Education in Southeast Asia. Interview by author. Singapore. 15 July 1985.

11. Newspapers:


13. Subsequent Reference Examples (for footnotes only):

- If more than one citation to a particular source appears in the work, subsequent references to that source need only to be noted in a shortened form. This applies to most all referenced materials.
- The shortened citation usually contains the author’s last name (unless others have the same name) and page number.
- If different works are cited that were written by the same author, the title of the work must also be included.
- The order then would be the author’s last name, title, and page number.
- Works with no author need to only list the title and page number.
- Make sure when citing books, the title is always italicized.
- When referencing the title of an article or similar type of reference, place the name of the title in “quotes.”

**BOOKS**

1. Only one book cited by author:
   
   ¹Bloesch, 12.

2. One book by more than one author:
   
   ²Fee and Stuart, 33.

3. Two books by the same author:
   
   ³Bloesch, *The Evangelical Renaissance*, 12.

   ⁴Bloesch, *The Invaded Church*, 56.

4. Kindle books
   
   ⁵Trible, Kindle ed.: chap. 4, loc. 288-90.

**JOURNALS/MAGAZINES**

1. One article cited by author:
   
   ¹Moore, 79.

2. One article by more than one author:
   
   ²Uzzi and Spiro, 2.
3. Two articles by the same author with successive pagination:

3Mercadante, “Are We All Immigrants?” 3-4. (cite all pages used)

4Mercadante, “Winners or Whiners?” 16. (For journals, magazines, articles, etc. list the title of the article rather than the title of periodical it came from, if the same author is cited for two different articles.)

- Examples are transferable to most all other types of referenced materials.
- Note: If an example of a particular source cannot be found in this manual or in Turabian, consult your professor for assistance.
- The above samples of style were adapted from Vyheister ch. 10, Turabian ch. 17, and SBL Handbook of Style ch. 7.
Example Pages

Reading maketh a full man, conference a ready man, and writing an exact man.

—Sir Francis Bacon
A Research Paper

Presented to

Dr. Professor’s Name

Graduate School of Theology and Ministry

Oral Roberts University

In Partial Fulfillment

of the Requirements for the Course

GTHE 517, Seminar in Theological Research

By

Your Name

Month Day 201__
Clearly one of the most distinctive points of time in the history of the church is the Pentecostal outpouring that came like a flood in the early part of the twentieth century. William J. Seymour was the dominant figure in this historic event . . .

The Azusa Street Revival significantly shaped and impacted the Pentecostal churches of America in the early part of the twentieth century. . . .

From a theological standpoint, many of these early Pentecostals sought to follow a literal interpretation of scripture. . . .

Their biblical understanding of Spirit baptism was that of an experience separate from sanctification. . . .

Fulfillment of Joel 2:28-32. They felt they were amidst a literal fulfillment of Joel 2:28-32. . . .
Although the debate between the cultic/figurative and the literal interpretation continues, there is no doubt that Malachi calls for faithfulness between husbands and wives because marriage is grounded in the covenant between the husband and wife and Yahweh. However, the traditional view identifies marriage as a covenant and one of the most important scholars to support this view is Gordon Paul Hugenberger. In his book, *Marriage as a Covenant*, he presents a thoroughly researched study in biblical ethics especially in the concept of marriage as held by Malachi and other Bible writers. Hugenberger argues that Malachi 2:14 refers to a literal marriage covenant and not to a figurative one as some scholars believe. Malachi 2:14 reads: 

And you say wherefore? Because the Lord has been a witness between you and the wife of your youth, against whom you have been faithless, though she is your companion and your wife by covenant.

Hugenberger argues that the endearing designation “the wife of your youth” in 2:14 is in parallel with “the wife of your covenant.” This implies that the covenant in 2:14 was between the husband and wife. In Genesis 31:50, the reference of the . . .

---

2. Author’s translation.


**Periodicals**


**Other Sources**

GREEK AND HEBREW TEXT CITATION EXAMPLES

Greek Text Citation Sample

- Both Greek and English texts are indented half an inch from the left margin and single-spaced.
- Greek block quotes need to begin double-spaced after the text.
- The translation of the verse must begin double-spaced after the citation of the Greek text.
- At the end of the translation, double space between the translation and the start of the remainder of the main body of text.
- Both the Greek text block quote and translation need to be single-spaced.
- See example below:

30 Τί οὖν ἔρουμεν; ὡτι ἐθνη τὰ μὴ διώκοντα δικαιοσύνην κατέλαβεν δικαιοσύνην, δικαιοσύνην δὲ τὴν ἐκ πίστεως, 31 Ἰσραήλ δὲ διώκων νόμον δικαιοσύνης εἰς ὁμον οὐκ ἐφθασεν. 32 διὰ τί; ὡτι οὐκ ἐκ πίστεως ἀλλ ὡς ἐξ ἔργων. προσέκοφαν τῷ λόῳ τὸν προσκόμματος, 33 καθώς γέγραπται. Ίδου τίθημι ἐν Σιών λίθον προσκόμματος καὶ πέτραν σκανδάλου, καὶ ὁ πιστεύων ἐπ αὐτῷ οὐ κατασχινθήσεται.¹

30 What then shall we say? That Gentiles, who did not seek after righteousness, obtained righteousness, namely the righteousness which is based on faith. 31 But Israel, pursuing after a law of righteousness, did not attain that law. 32 Why not? Because it was not on the basis of faith, but as if it were based on works. They have stumbled over the stumbling stone, 33 as it is written, "See, I am laying in Zion a stone of stumbling, a rock of offense, and whoever believes in him will not be disappointed."²

Paul begins this new section (Rom 9:30-31) with a paradoxical statement: Gentiles got what they did not pursue (namely, righteousness), while the Jews did not obtain what they pursued (righteousness based on the law).


²Author’s translation.
Hebrew Text Citation Sample

- Hebrew block quotes need to begin double-spaced after the previous text.
- Block quotes are single-spaced.
- Hebrew text is right justified.
- The English translation of the verse must begin double-spaced after the citation of the Hebrew text and will be single-spaced and indented 0.5 inches.
- At the end of the English translation, double space between the translation and the start of the remainder of the main body of text.
- See example below:

This righteousness and wickedness referred, of course, only to the particular lawsuit and not to a general reputation of the litigants. This type of language is used for example in Deuteronomy 25:1-2:

When there is a strife between men and they go to the court, the judges will judge them, justifying the righteous and condemning the guilty. Then if the guilty man deserves to be beaten, the judge shall cause him to lie down and be beaten in his presence with a number of stripes in proportion to his offense.\(^2\)

In this case אֱלֹהִים (Hiphil of הшение) means, “declare to be righteous, or not guilty,”\(^3\)

and אֱלֹהִים (also Hiphil, resolve) means “condemn or declare to be guilty.”\(^4\)

---

1. All Hebrew references are from *Biblia Hebraica Stuttgartensia,* 5th corrected ed. corrected (Stuttgart: United Bible Societies, 1997).

2. Author’s translation.


Miscellaneous

Common Mistakes

The skill of writing is to create a context in which other people can think.

—Edwin Schlossberg
COMMON PROBLEMS WITH FORM AND STYLE

Also see corresponding topics in Form and Style Section of this manual.

Bibliography:
- Cites not matching footnotes, or contained in one place but not the other
- Only list sources used in text
- Problems with bibliographic format—where to place sources within three categories: Books, Periodicals, or Other Sources.
- Separate entry not included for each word referenced in a concordance, lexicon, etc.
- Not using proper format

Consistency: Inconsistency throughout paper with form and style.

Contractions: Using contractions (contractions may not be used in academic papers).

Ellipses: No space between word and ellipsis; no space between dots of ellipses.

Emphasis Added:
Not using [emphasis added] when italicizing words/phrases in a quotation for emphasis; underlining or quotation marks are also options.

First Pages:
First pages of papers/bibliography/(& M.A. Thesis chapters) not done in proper format: 2” top margin, page number at bottom center, 3/4” from bottom of page; subsequent pages: 1.4” top margin, page numbers 1” from top and right margins.

Footnotes:
- Not using proper format: 12 pt font; indent first line 0.5”; single space footnotes; double space between footnotes.
Footnote number and footnote on separate pages; indicated by footnote line all across bottom of page.

Front Matter (M.A. Thesis): Not in proper format and not submitted with first chapter.

Italics: Not italicizing foreign transliterations (e.g., agape, shalom, koinonia, harpazo, etc.). But do not italicize words/phrases in non-English alphabets (Greek or Hebrew).

Names, Full: Not using full names in first time use of quotes, then last name thereafter.
COMMON PROBLEMS WITH FORM & STYLE  continued

**Paragraph, format:** Some paragraphs do not contain at least three sentences (try to avoid lengthy sentences).

**Person:** Paper not written completely in third person. Do not use first person (“I,” “me,” “we,” or “us”) or second person (“you”).

**Punctuation:** Improper use of capitalization, commas, semicolons, parentheses, and ellipses.

**Quotations, block:** Not using block quotations for five or more lines of quoted text (and foreign language quotes); (make liberal use of ellipses . . . only quote “heart of the matter”/central concept), or foreign quotes.

**Quotations:**
- Not introducing all quotations.
- Using too much quoted material. Ensure that copyright “Fair Use Rule” not violated.

**Spacing (M.A. Thesis):** Line spacing between headings and subheadings not formatted properly.

**Scripture reference:** Not using general Scripture footnote at first Scripture reference, then parenthetically thereafter.

**Starting Sentences:** Starting a sentence with a number, quotation, or foreign word.

**Table of Contents (M.A. Thesis):** Headings must match exact text of headings in body of thesis.

**Title:** Lines of title not in inverted pyramid format (for multiple line titles only).

**Widows and Orphans:** Only one line at bottom of page starting a paragraph, or only one line at top of page ending a paragraph from previous page.